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Calendar Magic – Version History 
 
Version 17.5 April 7, 2010 
 
World Clocks 
At the request of a user, added functionality (Time > World Clocks) for simultaneously displaying the 
local times at up to 12 different world-wide locations. The times displayed are continuously updated, 
minute by minute. The countries and locations chosen are “sticky” values. 
 
Planning Calendars 
Also at the request of a user, added a new type of planning calendar (Calendars > Planning Calendars 
> Academic Calendar). An “academic calendar” shows 12 consecutive months but the first month may 
be chosen as any month of the year. 
 
Statistics Calculator 
Any displayed plot (Box, XY, Regression Line) may now be viewed in “enlarged mode” by pressing the 
F11 function key. 
 
Data input files may now contain times specified in HH:MM:SS format, for example 15:23:07. Such 
times are converted into decimal hours during data input. Also, if times do occur in a data input file, the 
field separator must obviously not be a colon. 
 
Increased the limit on the number of data lines in a file from 1000 to 2000. 
 
Strengthened the detection of errors in input data files. 
 
Recurring Decimals 
Added a Recurring Decimals capability (Utilities > Recurring Decimals) for converting fractions to 
decimal form and vice-versa. For example 23/1400 converts to 0.016(428571), with rounded 
parentheses being used to indicate the periodic part which repeats indefinitely. 
 
For more information, consult the Recurring Decimals section later in this document. 
 
Password Protection 
Password input when starting Calendar Magic is now “asterisk protected”, improving overall security 
when passwords are used. 
 
Dates 
You can now list the years and locations of modern Summer Olympic Games (Dates > Summer 
Olympic Games) and also Winter Olympic Games (Dates > Winter Olympic Games). 
 
Date Conversions 
Added Winter Olympic Games locations information. Updated Summer Olympic Games data to 
include Rio de Janeiro in 2016. 
 
World-wide Locations Database 
Updated time zone and DST information and incorporated recent major changes in Russia and 
Mexico. 
 
At the request of users, added Hervey Bay, Queensland, Australia and Lincoln, California, USA  to 
Calendar Magic’s world-wide locations database. 
 
Observed Days 
Updated information for England, Northern Ireland, Scotland and Wales for 2012 and added extra 
Bank Holiday in that year. 
 
Where applicable, Daylight Saving Time (DST) start and end dates are now only displayed for the 
current year. With the many DST changes taking place throughout the world, maintaining DST data 
across multiple years was proving to be too onerous a task. 
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Use of Windows Clipboard 
Added code to address occasional copy and paste problems on systems running a Clipboard 
manager. 
 
Scientific Calculator 
Improved detection of invalid keyboard input. 
 
Excessive I/O Reads 
An American user, Ross Burnett, figured out that Calendar Magic was repeatedly reading the contents 
of one particular data file, thereby causing an excessive number of I/O read operations. This has been 
fixed in V17.5. My thanks to Ross for his detective work. 
 
Timer Code 
Fixed an error in the Timer code, detected while developing and testing World Clocks. 
 
Version 17.4 December 22, 2009 
 

1. Implemented a simple Statistics Calculator (Utilities > Statistics Calculator). The initial release 
contains procedures for the basic statistics of ungrouped data, the basic statistics of grouped 
data and several types of 2-variable regression (linear, logarithmic, exponential, power, 
quadratic). Depending on user feedback, other statistical procedures will be implemented in 
the future. 

 
Data plotting capabilities are also available – Box plots, XY plots and regression line plots. 

 
Data files must be plain text files in CSV format, although using a comma as the field 
separator is not recommended. The default file extension is .sta. A simple Data Editor is 
provided for creating such files but any text editor or spreadsheet program may be used. 

 
2. Added a new utility (Utilities > Average Speed) for calculating any one of distance travelled, 

time taken and average speed, given values for the other two. Input may be expressed in 
various units of distance, time and speed. 

 
3. Changed the default colours for the various forms in Calendar Magic. For existing users, only 

“new forms” in Calendar Magic will show the new colour scheme. To apply the new colour 
scheme to all forms,  use  Options > Colour > Restore All Screens to Default Colours. 

 
4. Updated blood alcohol limit data for various countries. 

 
5. In the Travelling Salesman Problem utility, modified the logical flow to bring it more into line 

with that adopted for the new Statistics Calculator. 
 

Provided three .tsp files, “EU capitals.tsp”, “US state capitals.tsp” and “World capitals.tsp”, 
containing respectively the data for all EU country capitals, all US state capitals and 222 world 
capitals. 

 
6. Statistics Calculator data files (*.sta) have been added to the various types of files backed up, 

as have Fraction Calculator saved history files (*.sff). 
 

7. Added additional Thai observed day information for 2010. 
 

8. Other minor enhancements and bug fixes. 
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Version 17.3 May 27, 2009 
 

1. Successfully tested V17.3 on the 64-bit version of Windows 7 RC1. 
 

2. Responding to a user’s suggestion, you may now password protect your copy of Calendar 
Magic by means of a new Password Manager (Options > Password Manager). Using it, 
passwords may be created, changed and removed. Any password created must be at least 
eight characters long and must consist of a combination of letters (a to z, A to Z) and/or digits 
(0 to 9). 
 
If a password has been created, whenever anyone attempts to open that copy of Calendar 
Magic, he/she is prompted to input the password and Calendar Magic will not open until this 
has been done successfully. 

 
3. Added new functionality to the Big Numbers Calculator – sqrt(x) , where x is a non-negative 

decimal number of arbitrary length, and the calculation of the mathematical constants pi, e and 
phi (the golden ratio). The calculation of these three constants is done using Steve 
Pagliarulo’s super-fast QuickPi program, distributed as part of V17.3 with Steve’s approval. By 
way of example, the calculation of pi to 1,000,000 decimal places takes around 2 seconds! 

 
4. Implemented an algorithm for solving the Travelling Salesman problem (Utilities > Travelling 

Salesman Problem). The problem concerns a salesman who has to visit a number of 
cities/towns by air and who is keen to minimise the total distance travelled. 
 
The algorithm used is called “simulated annealing” and is based on the approach “nature 
uses” when a metal anneals or when a crystal forms. It was described by Shawn Carlson in 
the March, 1997 issue of Scientific American. 

 
5. Implemented a Fraction Calculator (Utilities > Fraction Calculator) to calculate exactly the 

values of arithmetic expressions containing integers and fractions. For example, 22/7 - 
355/113 simplifies to 1/791. Permissible arithmetic operators are +  -  *  / and ^. Three types of 
parentheses, namely (  ),  [  ] and {  }, may be used and user defined variable names are also 
supported. More detail is provided later in this document. 

 
6. Implemented a Continued Fraction Calculator (Utilities > Continued Fraction Calculator) for 

evaluating continued fractions and for converting arithmetic expressions of the forms: 
 

x x / y   sqrt(x)   (x + sqrt(z)) / y  (x - sqrt(z)) / y 
 
to continued fractions. The solution of linear Diophantine equations in two variables is also 
supported, as is the solution of Pell’s equation. More detail is provided later in this document. 

 
7. In the Big Numbers Calculator, rationalised the retention of input values when switching 

between different types of calculation. 
 

8. In the Expression Calculator, improved the detection of invalid input. 
 

9. Added a check box to the Calendar Options form (Options > Calendar Options) for 
suppressing seconds in the display of the current time. This applies to all forms in which the 
current time is displayed. 

 
10. Extended the functionality of the Time Calculator by providing an option which supports the 

calculation of the positive difference between two date related times, for example 15:45:20 on 
Dec. 15, 2004 and 21:20:35 on Feb. 27, 2010. 

 
11. When a form in Calendar Magic contains a single spin button (double red arrowhead in 

appearance), the keyboard key combinations Ctrl++ and Ctrl+- may now be used as 
alternatives to clicking the red arrowheads. Ctrl++ increases the value controlled by the spin 
button and Ctrl+- decreases the value. When a form contains more than one spin button, you 
must first left-click the control containing the value you wish to change. 

12. Added new items to the File Menu for restoring backed up data files, namely Restore All, 
Restore Initialisation File, Restore Quick Notes and Restore Reminders. 
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13. In line with a user suggestion, the Display Fonts and User Fonts forms now contain “sample 
text” fields formatted using the chosen font specifications. This makes it much easier for users 
to assess the impact of choosing a different fixed width or proportional width font, changing 
font sizes etc.  

 
14. Added Birkat ha-Hammah (The Blessing of the Sun) to the list of Jewish religious festivals. 

This festival is celebrated once every 28 years on a fixed date (March 26) in the Julian 
calendar. The festival will be celebrated next on April 8, 2009. My thanks to Robert van Gent 
for bringing this festival to my attention. For further information, see: 
 
http://en.wikipedia.org/wiki/Birkat_HaHammah 

 
15. Added Save buttons to various forms for saving results to a text file. 

 
16. Improved the visual display of Moon phases on the Sun and Moon Data form and reworked 

the underlying code. 
 

17. Various minor enhancements and bug fixes. 
 
Version 17.2 February 1, 2009 
 

1. Added a Body Mass Index (BMI) Calculator (Utilities > BMI Calculator) in response to users’ 
requests. The indicated BMI category follows World Health Organisation (WHO) guidelines. 
 
Any weight or height entered may not only be a numerical value but also a simple arithmetic 
expression. For example, someone in the United Kingdom, whose height is 5 ft 10 ½  ins, 
could enter it as 5 * 12 + 10.5 ins, since there are 12 inches in a foot. 
 
Numeric input fields in many other parts of Calendar Magic may now be similarly specified, 
including the Financial Calculator, Geometry Calculator, Fuel Consumption, Global Distances, 
Paper Weight Converter, Unit Converter and BAC Calculator. The arithmetic expression may 
contain numeric values, rounded parentheses ( ), and the arithmetic operators +  -  *  /  and  ^, 
representing respectively addition, subtraction, multiplication, division and raising to a power. 
Examples are 5 * 23.79, 11 * 14 + 6 and (2 ^ 0.5) * (7 / 8). The space characters on either side 
of an arithmetic operator are optional. 

 
2. Implemented a “Big Numbers Calculator” (Utilities > Big Number Calculator) for performing 

calculations involving very large non-negative numbers. The calculations initially supported 
are x + y,  x - y,  x * y,  x / y, x ^ n,  x \ y,  x mod y,  hcf(x, y),  lcm(x, y)  and  n!. 
 
Note that arithmetic expressions may not be used when providing input values to the Big 
Numbers Calculator. You can however, when entering values for x and y, use “E notation”. For 
example, 1.7E6 is equivalent to 1.7 times 106 – that is the number 1700000. Similarly, 2.57E-8 
is equivalent to 2.57 times 10-8 – that is the number 0.0000000257. 
 
Whenever a result will contain more than 5000 digits, you are prompted to confirm that you 
wish to proceed. You may also terminate any calculation, taking an unacceptably long time, by 
pressing the keyboard key combination Ctrl+T. 

 
3. Implemented a “Number Base Converter” in response to another user suggestion. Numbers 

may be converted between any two number bases in the range 2 (binary) to 100. A number to 
be converted may be of arbitrary length and may also be non-integer. 
 
For inputting numbers in number bases greater than 16, Neugebauer’s notation must be used. 
For inputting numbers in number bases from 2 to 16, you may use either Neugebauer’s 
notation or normal mathematical form. 
 
Note that, with the release of the Number Base Converter, the much more limited “Number 
Bases” category in the Unit Converter has been removed. 

  

http://en.wikipedia.org/wiki/Birkat_HaHammah
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4. Another user requested an easy way to add the dates of Moon phases to his stored 
reminders. Now, whenever the Sun and Moon Data utility is run with a date in "this year" or 
"next year", a text file newrems.txt is automatically generated containing Moon phase date 
records of the form: 

 
day, month, year, moon phase description 

 
an example being : 

 
4, 1, 2009, First Quarter 

 
The data in this file can then be added to your stored reminders by using the “Import 
reminders” utility (Reminders > Reminder Utilities). 

 
5. Implemented a facility (File > Backup) for making a backup copy of important data files 

containing, for example, set reminders, Quick Notes text, user customisations of Calendar 
Magic etc. 

 
6. Added a check box to the Reminder Utilities form (Reminders > Reminder Utilities) for turning 

on and off the audio warning signal for imminent reminders. Suggested by a user. 
 

7. Satisfying another user request, in any list of observed days for Israel and in any list of Jewish 
religious festivals, all the days of Pesach, Chanukah, Rosh Hashana and Sukkot are now 
explicitly listed. 

 
8. Redesigned the Time Calculator and Unit Converter forms. 

 
9. The output from Date Conversions now includes the number of Sundays, Mondays, Tuesdays 

etc in the relevant year. 
 

10. Updated the time zone information for locations in Brazil. On June 24, 2008 the Brazilian 
Government abolished the country’s fourth time zone (UTC – 5). 

 
11. Updated the DST rules for Brazil. DST now begins on the third Sunday in October and ends 

on the third Sunday in February. 
 

12. Added DST rules for Argentina and Mauritius. 
 

13. Updated the BAC data for various countries and added data for 20 more countries. 
 

14. Added World Toilet Day (Nov. 19) to the list of Observed Days under “various”. See, for 
example: 

 
 http://en.wikipedia.org/wiki/World_Toilet_Day 

 
15. Separate forms have been created for This is Your Life, New Year’s Days, On This Date, 

Factor Calculator and Magic Squares. 
 

16. The standard Windows Common Dialogue is now used throughout Calendar Magic for saving 
output to a text file. 

 
17. In Global Distances, fixed a bug in the code for "Direction from A to B" etc. which could cause 

erroneous results to be produced in certain rare cases. 
 

18. In the BAC Calculator, fixed an input bug which could occur in countries where the comma is 
used as the decimal point. 

 
19. Corrected the date of Father’s Day in Denmark. 

 
20. Various other minor bug fixes. 

 

http://en.wikipedia.org/wiki/World_Toilet_Day
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Version 17.1 September 17, 2008 
 

1. At the suggestion of a user, added a new type of planning calendar (Calendars > Planning 
Calendars) for teachers and academics. The “Teachers Calendar” is a full academic year 
calendar listing the various months in an academic year and also numbering the various 
weeks in each academic term. 
 
Input for a Teachers Calendar consists of the number of terms per academic year plus the 
starting and ending dates of each term. Input values are “sticky” until the number of terms is 
changed, at which point term starting and ending dates must clearly be redefined. 

 
2. Implemented date conversions to the Aztec Xiuhpohualli calendar. The implementation and 

naming conventions are in line with the Aztec calendar description and calculator at 
http://www.azteccalendar.com/. 

 
3. Implemented the Yoruba calendar system (via the menu items Calendars > Dual Calendars 

and Calendars > Year Calendars) and date conversions to and from Yoruba calendar dates. 
The implementation follows http://www.ngex.com/news/public/acomments.php?ArticleID=816 
and should be regarded as experimental at this stage until further confirmatory evidence 
becomes available. 

 
4. In the Alarm Clock, changed the specification of the duration of an alarm from minutes to 

seconds. This enables users to specify repetitive alarms of much shorter duration, for example 
a 5 seconds reminder every few minutes to save a document being edited. The maximum 
duration of an alarm remains unchanged – 5 minutes previously and now 300 seconds. 
 
Note that a short alarm requires a suitably short associated music file, since any music file, 
once started, is played to completion. 

 
5. In Global Distances, you may now specify a location by providing its latitude and longitude. 

This could be useful when using a SatNav or other GPS based device. 
 

6. Improved the coverage of South African cities and towns in Calendar Magic’s world-wide 
database. 

 
7. Updated the transliterated Coptic month names in line with the third edition of Calendrical 

Calculations by Dershowitz and Reingold. 
 

8. Updated DST information for Australia, Cuba and Guatemala. 
 

9. Added Democracy Day (May 29) to the list of observed days for Nigeria. 
 

10. Added the option “Fifth” to the choices for Type 2 reminders to support the creation of 
reminders for, say, the fifth Friday in every month in a specified range. Months in which the 
“fifth Friday” does not exist are simply ignored. 

 
11. At the suggestion of a user, added a “Save” button to the Planning Calendars form for saving 

any calendar produced to a text file. Added a similar button to the Year Calendars and Dual 
Calendars forms. 

 
12. Fixed a bug in the handling of “Second last” Type 2 reminders. 

 
13. Fixed the display of moon phases for users in the southern hemisphere, where the moon 

waxes from left to right – the opposite behaviour to that observable in the northern 
hemisphere. Spotted by an eagle eyed Australian user, Louis Bialy. 

 
14. Corrected the date of St. Patrick’s Day in the Republic of Ireland in 2008. Because the normal 

date of St. Patrick’s Day (March 17) falls in Holy Week in 2008, the date was changed to 
March 15. The problem will not re-occur in the remainder of this Century. 

 
15. Improved the layout of the Greek Olympiad Conversion form. 

 

http://www.azteccalendar.com/
http://www.ngex.com/news/public/acomments.php?ArticleID=816
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16. Improved the logic of the Ovulation Calculator. If the first predicted maximum fertility date is in 
the past, it is now ignored without any error message being generated. 

 
17. The fact that several forms require a Gregorian date as input has been made more explicit. 

 
18. Added a section to the readme file containing links to calendar and date related historic 

documents. 
 

19. Various minor cosmetic improvements. 
 
Version 17.0 February 17, 2008 
 

1. At the suggestion of a user, you may now specify the music file to be played when a set alarm 
goes off. A new combo box on the Alarm Clock form (Time > Alarm Clock) lists the names of 
all cda, mp3, m4a, m4p, ogg, wav and wma files in the folder in which Calendar Magic is 
installed, so that you may choose any favourite music file you have copied to this folder. The 
file name chosen is “sticky”.  
 
To play a music file, other than a wav file, Calendar Magic uses the music player software on 
your PC associated with the file extension. 

 
2. Encouraged by a Balinese user, implemented the Balinese Saka lunisolar calendar, widely 

used throughout the island of Bali. This calendar may now be selected in Year Calendars, 
Month Calendars, Dual Calendars and Calendar Comparison. Conversion to and from 
Balinese Saka calendar dates has also been implemented. 

 
3. Implemented the Balinese Pawukon calendar in Year Calendars. For each day in any chosen 

Gregorian year, the first half of the output shows the Pawukon Wuku (week) name followed by 
the values of the day names in the 10 simultaneous Pawukon cycles. The second half of the 
output lists, day by day, the values of Ingkel,  Parerasan , Panca Suda, Lintang and Ekajala 
Rasi.  
 
Note that printing a Balinese Pawukon calendar should be done in landscape mode and that 
the output is lengthy – more than 800 lines.  
 
The values of Wuku, Ingkel,  Ingkel Jejepan, Watek, Rakam, Parerasan , Panca Suda, Dewa, 
Wayang, Taru, Manuk, Sato, Lintang and Ekajala Rasi also now appear in Date Conversions 
output. 

 
4. Created a new category of religious festivals for listing the dates of Balinese Hindu festivals 

and holy days in any (Gregorian) year. Festivals based on both the Balinese Pawukon and 
Saka calendars are included. 

 
5. At the request of a user, added an Ovulation Calculator (Utilities > Ovulation Calculator) for 

predicting the dates of maximum fertility days. Once calculated, the dates may be printed or 
added to your set reminders via an “Add to My Reminders” command button. 

 
6. Added civil, nautical and astronomical twilight time information to the output from Sun and 

Moon Data (Utilities > Sun and Moon Data). 
 

7. If you have a multi-line mathematical expression already prepared using a text editor or word 
processor, you can now copy and paste it into the Expression Calculator and then press the 
Recalc All button to have the various lines processed. Of course, any such mathematical 
expression must conform to the syntactic rules of the Expression Calculator. An added bonus 
is that, if you use the Ctrl+V keyboard key combination to paste the expression, decimal points 
will be automatically converted into commas, or vice-versa, depending on your “Decimal 
symbol” Windows setting. 

 
8. In the Geometry Calculator, added the aspect ratio 16:10 when calculating the attributes of 

television screens. 
 

9. At the suggestion of a user, “This is Your Life” output now includes a person’s age in years, 
months and days according to the Islamic calendar. This is important in Islam where the 
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commencement of various religious duties is based on a young person’s Islamic calendar age. 
The calculation is performed using the variant of the Islamic arithmetical calendar chosen by 
the user (Options > Calendar). 

 
10. Added a “Print in Alphabetical Order” button to the Observed Days and Religious Festivals 

forms. Also made some improvements to these forms. 
 

11. Added ordinal date format (http://en.wikipedia.org/wiki/ISO_8601#Ordinal_dates) to the output 
from Date Conversions. 

 
12. Added more locations on Tenerife to Calendar Magic’s world-wide database. Fixed a few bugs 

in the data for the Canary Islands. 
 

13. When a Chinese or Vietnamese calendar is selected in Month Calendars or Calendar 
Comparison, the creature associated with the year (pig, rat, ox etc.) is now displayed. 

 
14. Updated Commonwealth Games data. 

 
15. Improved the layout of the Dual Calendars, Pregnancy Calculator and Regnal Dates 

Conversion forms. Dual calendars may now be printed on a single A4 page, provided that a 
sufficiently small font is used. 

 
16. Corrected the spelling of the transliterated Islamic day name Yaum al-khamis. 

 
17. Changed the Hebrew month name “Marcheshvan” to “Cheshvan”. 

 
Version 16.9 October 14, 2007 
 

1. For users who dislike the Courier New and Arial fonts, you may now specify the fixed width 
and proportional width “display fonts” used by Calendar Magic via a new menu item Options > 
Display Fonts. These fonts are “sticky” and are used to format the results displayed in the 
main output text boxes on various forms in Calendar Magic. 

 
Similarly, you may now specify the fixed width and proportional width “user fonts” used by 
Calendar Magic via a new menu item Options > User Fonts. These fonts are also “sticky” and 
are used to format user created text such as Quick Notes and reminder messages. This 
second facility is particularly useful to users who wish, for example, to create text in a 
language other than English. 

 
You are advised to experiment with some caution when changing the Calendar Magic font 
defaults. For example, too large a font size may impact the appearance of output on certain 
screens and exotic fonts may not contain all the characters used in Calendar Magic. A “Reset 
Defaults” button is provided in both cases as an “insurance policy”. 

 
2. Removed the Islamic calendar for North America as endorsed by the Islamic Society of North 

America (ISNA) in 2006. It is no longer being used, the decision having been taken to replace 
it by the Umm al-Qura calendar of Saudi Arabia. 

 
3. Implemented the Islamic Umm al-Qura calendar throughout Calendar Magic for the range of 

years 1356 A.H. to 1500 A.H. (approximately 1937 to 2077 in the Gregorian calendar). The 
Umm al-Qura calendar is used not only in Saudi Arabia, and now North America, but also in 
countries such as Bahrain and Qatar. 

 
The implementation is based on data kindly provided by Robert van Gent of the University of 
Utrecht. For further information, consult his web page: 

 
http://www.phys.uu.nl/~vgent/islam/ummalqura.htm 

 
4. In the Gregorian year range 1938 to 2076, the dates of Islamic religious festivals are now 

calculated using the Umm al-Qura calendar. Similarly, the dates of Islamic related observed 
days in Saudi Arabia, Bahrain and Qatar, up to 2076, are also calculated using the Umm al-
Qura calendar. 

 

http://en.wikipedia.org/wiki/ISO_8601#Ordinal_dates
http://www.phys.uu.nl/~vgent/islam/ummalqura.htm
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5. Implemented the concept of “Dual Calendars” accessed via the new menu item Calendars > 
Dual Calendars. These are full year calendars in various calendar systems which show, not 
only the months and days for a year in any one of the calendar systems, but also the 
corresponding Gregorian dates. 

 
6. Added a “Paper Weight Converter” (Utilities > Paper Weight Converter) for converting 

between metric paper weights (expressed in grams/metre2) and American paper basis weights 
(expressed in pounds). See, for example: 

 
http://en.wikipedia.org/wiki/Paper_density 

 
7. Added a “UK Tax Year Calendar” to the list of available Planning Calendars (Calendars > 

Planning Calendars). UK tax years run from April 6 to April 5 in the following year. 
 

8. Added a form (Dates > Greek Olympiads) for converting ancient Greek Olympiad numbering, 
for example year 3 of the 17th Olympiad, to and from calendar years. 

 
9. Added the day of the week and the ISO week number to each entry in a Day List calendar 

(Calendars > Planning Calendars > Day List Calendar). 
 

10. You can now display visual representations of the various 2D and 3D geometric objects in the 
Geometry Calculator. These are available through two new menu items in the Help menu, 
namely “2D Geometric Objects” and “3D Geometric Objects”. 

 
11. In the Geometry Calculator, output from circular ring (annulus) calculations now includes the 

lengths of the inner and outer perimeters. 
 

12. The output from “This is Your Life” now includes your current age in years, months and days. 
 

13. In Date Conversions, if a Gregorian date in the range September 14, 1752 to today’s date is 
converted, the output now includes the British monarch’s regnal year in which the date 
occurred. Similarly, if a Julian date in the range December 25, 1066 to September 2, 1752 is 
converted, the output also includes the British monarch’s regnal year in which the date 
occurred. The two date ranges are handled separately because of the change-over in Great 
Britain in 1752 from the Julian calendar to the Gregorian calendar. 

 
14. Changed the country name “East Timor” to “Timor-Leste” throughout Calendar Magic’s world-

wide locations database. Note that users with customised versions of the files mycountry.dat 
and mycities.dat may have to make a similar change in these files. The Observed Day 
information for Timor-Leste has also been updated. 

 
15. Updated Daylight Saving Time (DST) information for Australia, Brazil, Iran, Jordan and New 

Zealand in the light of recent changes. 
 

16. The time zone for Venezuela has changed from GMT – 4 hours to GMT – 4.5 hours. 
 

17. Five counties in Indiana (Daviess, Dubois, Knox, Martin and Pike) have moved from the 
Central time zone to the Eastern time zone in the United States. Time zone data for cities and 
towns in these counties has been updated. 

 
18. Improved the layout of generated solar calendars. 

 
19. Fixed a minor bug in the printing of Date Conversions output. A proportional width font was 

being incorrectly applied. 
 
Version 16.8 July 18, 2007 
 
1. Calendar Magic is now compatible with 32-bit Windows Vista. To keep life simple for both the 

developer and users, the default installation folder is now c:\EuroSoft\Calendar Magic. This default 
folder may be changed but, on Vista, do not install Calendar Magic as a sub-folder of c:\Program 
Files. 
 
Also, if you wish to transfer your personal settings by copying the file calmag.ini from a Windows 

http://en.wikipedia.org/wiki/Paper_density
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XP (or earlier) based installation of Calendar Magic, use a text editor to update the Printer Name 
entry in the [Form 29] section of calmag.ini to: 
 
Printer Name = (Default Printer) 
 
This is necessary because the assigned printer names in Vista and XP are not always identical. 

 
2. Implemented a Financial Calculator, accessed via Utilities > Financial Calculator. In this release, 

ten different financial calculations are supported – annuities, bonds, compound interest, fixed rate 
(declining balance) depreciation, straight-line depreciation, sum-of-years digits (SOYD) 
depreciation, general payments, margins (retail), mortgages and loans, and regular investments. 
Based on user feedback, other types of financial calculation will be added in the future. 

 
3. In line with the Geometry Calculator, when any result is calculated, the colour of label text 

associated with the calculated result changes to red, in order to distinguish more clearly between 
data input and calculated results. Also any input value may be specified as a simple arithmetic 
expression using not more than one of the arithmetic operators + - * / and ^ representing 
respectively addition, subtraction, multiplication, division and raising to a power. Examples are 5 * 
23.79, 2.57 / 2 and 2 ^ 0.5. The space characters on either side of an arithmetic operator are 
optional. 

 
4. Added a Favourites menu to the menu bar. You may choose the items displayed on the 

Favourites menu via a new Options menu item – Options > Favourites. Chosen favourite items are 
“sticky” until subsequently changed. 
 
You may also choose to hide the Favourites menu by clearing the “Show Favourites Menu” 
checkbox in Options > Favourites. 

 
5. Added a Fuel Consumption calculator (Utilities > Fuel Consumption). Although fuel consumption 

by distance and fuel consumption by volume routines already existed within the Unit Converter, 
user feedback indicated the need for a single set of results calculated from input specifying the 
distance travelled and the volume of fuel used. You may specify the number of significant digits to 
be displayed in results. This value is “sticky”. 

 
6. In the Unit Converter, the amount specified may now be a simple arithmetic expression using not 

more than one of the arithmetic operators + - * / and ^ representing respectively addition, 
subtraction, multiplication, division and raising to a power. This change brings the Unit Converter 
in line with the geometry and financial calculators. 

 
7. Added transliterated Chinese day of week names to the output from Date Conversions. 
 
8. Improved the appearance of the biorhythm information in the output from “This is Your Life”. 
 
9. At the request of users, added Arras, France and the Cocos (Keeling) Islands to Calendar Magic’s 

world-wide locations database. 
 
10. Removed “Canada Day” from the list of observed days for the USA. 
 
11. In “Special Calendars”, replaced “Czechoslovakia” by “Bohemia & Moravia” to improve historical 

accuracy. A note after the change-over calendar links them with the modern country (the Czech 
Republic) occupying roughly the same territory. 

 
12. Fixed a minor bug in the Geometry Calculator. Switching aspect ratios, after performing a 

Television Screen calculation, was incorrectly generating an error message. 
 
13. Fixed a bug relating to the personalised colouring of the BAC Calculator form. 
 
14. Fixed a sunrise/sunset related bug. When “Show Julian Day value on main screen” was 

unchecked in Options > Calendar, DST was not being correctly applied when calculating the 
sunrise and sunset times shown on the main screen. 
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Version 16.7 April 30, 2007 
 
1. Radically changed the user interface by replacing the numerous command buttons on the main 

screen by a menu bar. Advantages of so doing include the ease with which new functionality can 
now be provided, without adding more and more command buttons, and a reduced “footprint” for 
the main screen. 

 
2. The red or orange rectangle, which used to surround the Show Reminders button to indicate an 

imminent reminder, has been replaced by a red or orange diamond shape in the top right-hand 
corner of the main screen output text-box. Red indicates the existence of a set reminder for the 
current date and orange the existence of a set reminder less than 1 week away. You can get rid of 
the red or orange diamond by left-clicking it. 

 
3. At the request of several users, there is now a checkbox in Calendar options (Options > Calendar) 

for turning off the display of the Julian Day value on the main screen. 
 
4. Added a Save menu item (File > Save) to the menu bar for saving main screen output to a text 

file. It uses the standard Windows dialogue for saving to a file. 
 
5. Added a “Tip of the Day” menu item (Help > Tip of the Day) for displaying helpful hints for new 

users. A check box is provided for turning on and off the display of a “tip of the day” when 
Calendar Magic is started. 

 
6. Added an “About My Location” menu item (Help > About My Location) for consolidating and 

displaying various facts and figures about a user’s chosen location. 
 
7. “Before and After” (Dates > Before and After) now supports the calculation of the date y years m 

months w weeks d days before or after a given date. This helps to answer questions such as the 
one posed by a keen user – if Uncle Fred died on March 22, 2007 at age 92 years, 10 months and 
27 days, when was he born? Note that this is not always a precisely defined mathematical 
problem since months in the Gregorian calendar vary in length. 
 
In “Before and After”, in order to provide consistent results, working backwards is done in the 
order days, weeks, months and years, while working forwards is done in the order years, months, 
weeks and days. A warning message is also issued if a resulting date does not exist, for example 
1 year after Feb. 29, 2000. 

 
8. In the BAC Calculator (Utilities > BAC Calculator) , replaced the mean values for the Widmark 

factor r (0.68 for men and 0.55 for women) by computing r from formulas due to Seidl et al, 
namely: 
 
          r = 0.3161 - 0.004821W + 0.004632H (for men) 
 
          r = 0.3122 - 0.006446W + 0.004466H (for women) 
 
where W is the person’s weight in kilograms and H the person’s height in centimetres. Height and 
height unit are now “sticky” values. 

 
9. To support the conversion of Julian Day values to dates in the various supported calendar 

systems, added a “Julian Day” entry to the drop-down list of calendars on the Date Conversions 
form. 

 
10. Redesigned “In Which Months?” (Dates > In Which Months?) to cover a range of years rather than 

a single year. The drop-down list of day names is also now ordered starting from the week start 
day selected in Calendar options (Options > Calendar). For example, if your preferred week start 
day is Saturday, the drop-down list of day names will be in the order Saturday, Sunday, Monday, 
… Friday. 

 
11. Redesigned “Days between Dates” (Dates > Days between Dates). 
 
12. Redesigned the “Date Detective” (Dates > Date Detective). Also fixed a minor February 29 related 

bug which was causing an erroneous error message. 
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13. Redesigned the Edit Reminders form to reduce the amount of screen “real estate” occupied. 
 
14. Improved the appearance of listed reminders by removing superfluous commas from the displayed 

information. 
 
15. Removed Guadeloupe and Martinique from Calendar Magic’s list of countries and added the 

French Antilles, which include not only Guadeloupe and Martinique but also several other islands. 
Added a number of other towns in the French Antilles to Calendar Magic’s worldwide locations 
database. In all cases, the name of the town is followed, in parentheses, by the name of the island 
on which it is located. Adopted the same convention for locations in various island groups in other 
parts of the world. 
 
Note that all references to Guadeloupe and Martinique have been removed from the default 
versions of the files mycountry.dat and mycities.dat so that, if you have created personalised 
versions of these files, you may need to make corresponding updates. 

 
16. Restructured and updated the Help file. Created separate, short help files for menu bar items, 

special keyboard key combinations and version history. All three are available from the Help menu 
drop-down list of items. 

 
17. Added the date in 2007 of the Royal Ploughing Ceremony in Thailand. 
 
18. Fixed a bug causing the loading of the wrong colour scheme for a few forms. 
 
Version 16.6 March 15, 2007 
 
1. Added a “Solar Chart” command button to the Sun and Moon Data form for creating a 1-year 

graphical plot of sunrise, solar noon and sunset times for any specified year and location. Any 
solar chart created is automatically (a) copied to the Windows clipboard as a bitmap, and (b) 
stored as an image in the file SolarChart.bmp in the folder in which Calendar Magic is installed. 

 
2. Also added a “Daylight Chart” command button to the Sun and Moon Data form for creating a 1-

year graphical plot of numbers of daylight hours for any specified year and location. Any daylight 
chart created is automatically (a) copied to the Windows clipboard as a bitmap, and (b) stored as 
an image in the file DaylightChart.bmp in the folder in which Calendar Magic is installed. 

 
3. The F11 key may be used, as per normal, to display an enlarged view of a solar or daylight chart. 

In line with the above paragraphs, the enlarged chart is automatically (a) copied to the Windows 
clipboard as a bitmap, and (b) stored as an image in the file SolarChart.bmp or 
DaylightChart.bmp, overwriting the smaller version. 

 
4. Added a Blood Alcohol Content (BAC) calculator. The formula used is that recommended by the 

United States National Highway Traffic Safety Administration (NHTSA) and is based on Widmark’s 
formula. BAC legal limits in around 80 countries have been incorporated and others can be added 
on request. The input data values sex, weight, weight unit and country are all “sticky” values. 

 
It should be noted that there are various factors influencing BAC values which cannot be 
incorporated into a BAC calculator. As a result, any calculated BAC is approximate and should 
never be used to determine whether you are legally sober or fit to drive a car etc. 

 
5. Renamed the “Calendar for 1752” button as “Special Calendars”. Now via this button you can 

generate not only the 1752 Julian to Gregorian change-over calendar for Great Britain but also 
similar change-over calendars for Bulgaria, Czechoslovakia, Denmark, Estonia, Finland, France, 
Hungary, Ireland, Italy, Luxembourg, Norway, Poland, Portugal, Romania, Russia, Spain and 
Sweden. Two further buttons are provided to list the change-over information in both country and 
date order. 
 

6. For calculations require the use of Delta-T, the difference between dynamical and universal time, 
switched to the most recently published polynomial expressions for Delta-T, as described in the 
publication “Five Millennium Canon of Solar Eclipses” by Espanek and Meeus. For further 
information, see: 

 
http://sunearth.gsfc.nasa.gov/eclipse/SEcat5/deltatpoly.html 

http://sunearth.gsfc.nasa.gov/eclipse/SEcat5/deltatpoly.html
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7. Redesigned the Geometry Calculator form to reduce the amount of screen “real estate” occupied. 
 
8. In the Expression Calculator, you may now terminate any input line with the symbol # and there is 

a new checkbox “Ignore # lines” below the Recalc All button. If this checkbox is turned on, lines 
terminated by the symbol # are not recalculated during a Recalc All operation – useful, for 
example, when performing an iterative calculation in which various initial estimates are to be 
ignored after the first iteration. For an example, load the file NewtonRaphson.shf which forms part 
of this release. 

 
Apart from its use in conjunction with the “Ignore # lines” checkbox, the symbol # at the end of any 
input line has no other effect. 

 
9. Provided a number of sample Expression Calculator saved history (.shf) files. Topics covered 

include body mass index, cube roots, decimal degrees to degrees, minutes and seconds (and 
vice-versa), Netwon-Raphson iteration, screen resolution calculations, and the solution of 
quadratic equations. You are invited to contribute other examples for future releases. 

 
10. In Show Reminders, the number of days to go (DTG) is now shown for each event for which a 

reminder has been created. 
 
11. When using “This is Your Life”, the last valid date of birth entered is now a “sticky” value and is 

pre-filled into the data input box on subsequent usage. 
 
12. In Observed Days, added Mother’s Day and Father’s Day information for many additional 

countries plus some corrections. 
 
13. Added Pi Day (March 14) and Pi Approximation Day (Jul 22) to the list of Observed Days for 

“Various”. 
 
14. Added Stonehenge, England to Calendar Magic’s world-wide locations database. 
 
15. Added some more Antarctic locations to the same database – Belgrano Station, Bellinghausen, 

Halley Station, Macquarie Island Station, Mirny Station, Molodezhnaya Station, Neumayer Station, 
O’Higgins Station, SANAE and Scott Base. Also corrected the time zone information for the 
Amundsen-Scott Station. 

 
16. Updated the Observed Day information for Bahrain. My thanks to Mary Khonji for providing the 

relevant information. 
 
17. For consistency, vertically orientated all spin buttons throughout Calendar Magic. 
 
18. Corrected latitude and longitude information for Bundaberg, Queensland, Australia. 
 
19. Corrected time zone information for several locations in Mongolia. 
 
Version 16.5 January 18, 2007 
 
1. Changed the description “Islamic civil” to “Islamic arithmetical” throughout Calendar Magic. Also, 

in previous versions, only the most popular Islamic arithmetical calendar variant was implemented. 
Now, via new options in Personal Settings, you may choose from four different leap year schemes 
and one of two calendar epochs, Thursday, July 15, 622 and Friday, July 16, 622 (Julian). As a 
result, eight variants of the Islamic arithmetical calendar are now supported. The most popular 
variant (the default in Calendar Magic) uses the second leap year scheme from the drop-down list 
and the “Friday epoch”. Any values chosen are “sticky”. For further information, see: 

 
http://ww.phys.uu.nl/~vgent/islam/islam_tabcal.htm 

 
My thanks to Robert van Gent for bringing this to my attention. 

 
2. To maintain consistency with the above, moved the definition of the Mayan and Aztec correlation 

constant from the Date Conversions screen to the Personal Settings screen. 
 

http://ww.phys.uu.nl/~vgent/islam/islam_tabcal.htm
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3. In the Geometry Calculator, added ellipsoids to the list of 3D objects. Note that accurately 
calculating the surface area of an ellipsoid, in the general case where the semi-axes a, b and c are 
all of different lengths, is a non-trivial task. The following remarkable formula, due to Knud 
Thomsen, is used to obtain an approximate result: 

 
Surface area = 4π{(apbp + bpcp + cpap) / (3 - k(1 - 27abc / (a + b + c)3))}1/p 
 

where k=3/32 and p=ln(2)/ln(π/2). The absolute relative error is less than 0.21%. 
 
4. In the Geometry Calculator, added spherical triangles to the list of 3D objects. 
 
5. In the Geometry Calculator, added spherical domes to the list of 3D objects. 
 
6. In the Geometry Calculator, when working in degrees, tool-tips are now created during the 

calculation process for all enabled text boxes displaying angle values. Each tool-tip shows the 
corresponding decimal angle value converted to degrees, minutes and seconds. 

 
7. In the Geometry Calculator not all object attributes may be assigned input values and those which 

may not are “greyed out” (disabled) to identify them, making it impossible to copy such an attribute 
value to the Windows clipboard using the usual Ctrl+A and Ctrl+C keyboard commands. Now, to 
copy the value of any “greyed out” attribute to the clipboard, left-click the corresponding label 
description (this actually now works for all attribute values). 

 
8. In Global Distances, the direction of each chosen location from the other is now calculated as a 

number of degrees East or West of true North. This is useful for followers of the Islamic and 
Jewish faiths who wish to pray facing in the direction of Mecca and Jerusalem respectively. 

 
9. In the Expression Calculator, when saving a session history as an .shf file, the angle measure 

(degrees or radians) used during the session is now stored in the file. When the file is 
subsequently reloaded, the required angle measure is now automatically selected. “Older format” 
.shf files may still be loaded and the format  of such a file will be updated on a subsequent save 
operation. 

 
10. In the Reaction Timer, added the calculation and display of the average reaction time for a series 

of reaction time attempts and a corresponding reset button. 
 
11. Updated time zone offset from GMT for Sri Lanka which changed from 6 to 5.5 hours in 2006. 

Note that any Sri Lankan location in the file mycities.dat must be manually altered unless you 
allowed the existing file to be overwritten during the installation of V16.5. 

 
12. Updated DST information for 2007 for Canada, Bermuda, St. Pierre & Miquelon, Greenland, 

Guatemala and Nicaragua. 
 
13. Updated DST information for Australia, with the state of Western Australia implementing DST in 

December 2006 for a trial period of three years. 
 
14. Added Holte near Copenhagen to Calendar Magic’s world-wide locations database. 
 
15. Added Epiphany (Jan. 6) to the list of observed days for Italy. 
 
16. In Religious Festivals and Observed Days, speeded up the “behind the scenes” process of 

creating the files results.csv and newrems.txt. 
 
17. Improved the appearance and layout of the output from New Year’s Days, and parts of the output 

from Date Conversions and This is Your Life. 
 
18. Fixed a bug inadvertently introduced in V16.4. In Calendar Comparison, after clicking on a day in 

the left-hand calendar, the corresponding day in the right-hand calendar was not being updated. 
 
19. Fixed a formatting bug in Sun and Moon Data where occasionally a time was being shown as, for 

example, 07:60 rather than 08:00. 
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20. Fixed minor bug associated with re-enabling the Enlarged View “Previous Screen” button under 
certain circumstances. 

 
21. Various minor cosmetic changes and improvements. 
 
Version 16.4 December 5, 2006 
 
1. Added the recently defined Islamic calendar for North America as endorsed by the Islamic Society 

of North America (ISNA) in 2006. For details see: 
 
http://www.phys.uu.nl/~vgent/islam/isnacalendar.htm 

 
2. The ISNA Islamic calendar is fully implemented across the various calendar and date related 

functions in Calendar Magic including Year Calendars, Month Calendars, Calendar Comparison 
and Date Conversions. Islamic years 1427 to 2450 A.H. are covered, a time span corresponding 
roughly to 2006 to 2999 C.E.. The associated new moon date and time calculations require the 
use of Delta-T, the difference between dynamical and universal time. For estimates of Delta-T 
over this period, the NASA values given at: 

 
http://sunearth.gsfc.nasa.gov/eclipse/phase/phasecat.html 

 
have been used. 

 
Note that the Islamic civil calendar continues to be used for the calculation of the dates of Islamic 
religious festivals. 

 
3. Implemented a “reaction timer” which is invoked from the main screen by clicking the Reaction 

Timer button. After a random delay of up to 5 seconds,  a random letter is displayed and you must 
left-click the Stop button or press the keyboard Enter key as quickly as possible. 

 
4. When generating lists of Jewish religious festivals, the check-box “Include Sabbaths” has been 

changed to “Include weekly Torah readings” in order to provide more useful and pertinent 
information. The readings listed are for the Jewish Diaspora and are not applicable within Israel. 

 
5. Added code to prevent multiple instances of Calendar Magic being open at the same time. 
 
6. In the Geometry Calculator, added the torus to the list of 3D objects. 
 
7. In the Geometry Calculator, the radius r of the inscribed circle may now be specified or calculated 

for regular polygons. In addition, the number of sides n is now a mandatory input value. 
 
8. In the Geometry Calculator, pressing the keyboard Enter key now has the same effect as left-

clicking the Calculate button. 
 
9. Added a Save button to the Pregnancy Calculator for saving results to the plain text file 

pregnancy.txt. 
 
10. Added Balfour Day (Nov. 2) to the list of Observed Days for Israel. 
 
11. Added the town Saugerties in New York State to Calendar Magic’s worldwide locations database. 
 
12. Updated the 2007 Observed Day information for Cambodia, Indonesia, Lao, Malaysia, Myanmar, 

Niue, Thailand and the USA. 
 
13. Improved the layout of the Add Reminders screen. 
 
14. Starting/stopping an alarm is now handled in the same manner as starting/stopping the stopwatch, 

i.e. a single button is used for both operations. 
 
15. Corrected DST ending date for Brazil in 2007. 
 

http://www.phys.uu.nl/~vgent/islam/isnacalendar.htm
http://sunearth.gsfc.nasa.gov/eclipse/phase/phasecat.html
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16. Made a few button captions less verbose. For example, “Return to Main Screen” is now “Main 
Screen”, “Return to Previous Screen” is now “Previous Screen”, “Print to Printer” is now “Print”, 
and “Print to Text File” is now “Save”. 

 
17. When creating solar calendars, the explanation of the letters U, D, N and X no longer appears if 

the created calendar does not contain any of these letters. 
 
18. Various minor cosmetic changes and improvements. 
 
19. Fixed path related bug which could occur if Expression Calculator .shf files are stored in a folder 

other than the folder in which Calendar Magic is installed. 
 
20. Fixed minor bug in the Geometry Calculator which occurred when changing the number of 

significant digits in results after performing a calculation. 
 
Version 16.3 October 28, 2006  
 
1. The checks for imminent reminders (and the provision of visual and audio warnings when 

reminders are imminent) are now not only performed at program initiation but also, if Calendar 
Magic is running, at one second after midnight each day. In addition, if any set reminder is 
imminent, an appropriate message box is displayed. This extra functionality is required by users 
who do not switch off their PCs and who keep Calendar Magic permanently running in the 
background. 

 
2. Added a fifth type of planning calendar, namely a “Day List Calendar”. As the name suggests, this 

simply creates a long list of the various days in a specified period of any year. The period may be 
one month, two months, three months, four months, six months or the complete year, and multiple 
month periods must consist of consecutive months. The vertical spacing between days may also 
be controlled using a new spin button on the Planning Calendars form, with the number of blank 
lines between days being in the range 0 to 10. 

 
3. Added three new inbuilt functions to the Expression Calculator. The function invert(x) returns 1 if 

x=0 and 0 if x<>0. The function uservars returns a list of user defined variable names and the 
function userfuncs returns a list of user defined function names. For obvious reasons, these last 
two functions must be used in “stand-alone” mode and not as part of any arithmetic expression or 
statement. 

 
4. In the Expression Calculator, the standard Windows dialogue is now used for saving and loading 

session history files, indicated by the file extension .shf. Fairly obviously, if you have created 
session history files using any earlier version of Calendar Magic, you will need to manually change 
their file extensions to .shf. 

 
5. In the Expression Calculator, when loading a saved session history file, commas being used as 

decimal points in numbers will be automatically changed to periods if required (and vice-versa) in 
line with the Windows setting for decimal points. As a result, a session history saved, for example, 
in Denmark can be successfully loaded in the United Kingdom without the need to manually 
change any commas in numbers to periods. 

 
6. Improved the layout of the Expression Calculator. Also improved the handling of error situations, 

especially errors occurring when “Recalc All” is used. 
 
7. Improved the layout of the Pregnancy Calculator, simplified its usage and added a Print Results 

button. 
 
8. When a Religious Festivals or Observed Days list is generated for “this year” or “next year”, the 

relevant output data is now also stored in the text file newrems.txt with each line having the 
format: 

 
day, month, year, description 

 
9. The advantage of this is that reminders can then be easily created for these special days using the 

“Import reminders” function on the “Reminder Utilities” form. You may, of course, manipulate this 
file using a text editor, for example to delete any special days for which you do not wish reminders 
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created. For additional information, consult the section “Religious Festivals and Observed Days” in 
“Hints and Tips” later in this document. 

 
10. Added conversion to the Aztec sacred tonalpohualli calendar to the output from Date Conversions. 

The date correlation constant used is currently assumed to be identical to the Mayan date 
correlation constant. 

 
11. Added the dates of equinoxes and solstices to the list of Observed Days for “Various”. Such dates 

will also be detected when using “On This Date”. 
 
12. In the Geometry Calculator, the last 2D object chosen and the last 3D object chosen are now 

“sticky” values. 
 
13. In the Geometry Calculator, the colour of label text associated with calculated results now 

changes to red to distinguish between results and input data. In previous versions, label text 
associated with input data was coloured red to achieve the same objective but this could be 
misinterpreted by users as an indication of data input errors. 

 
14. Added some additional error detection code to the Geometry Calculator. 
 
15. Updated the ISO 3166-1 two letter country codes for Serbia and Montenegro. 
 
16. Updated the DST information for Brazil for 2006/2007. 
 
17. Updated the definition of the International Day of Peace (September 21 from 2002 onwards) in the 

list of Observed Days under “Various”. 
 
18. Added the unit kilograms/centimetre^2 to the category “Coverage – Mass per Area” in the Unit 

Converter. 
 
19. Added Israel Sunday (11th Sunday after Pentecost) to the list of Observed Days for Germany. 
 
20. Added the dates of the Tamil New Year in 2006 and 2007 to the observed days for Sri Lanka and 

India. 
 
21. Improved the layout of “Sun and Moon Data” output. 
 
22. The presence of a red or orange rectangle around the “Show Reminders” button, when set 

reminders are imminent, is now handled more logically after adding, deleting or modifying 
reminders. 

 
23. Clarified the fact that the date given for the Islamic festival Lailat-al-Qadr is an estimate since, 

although it occurs in the last 10 days of Ramadan each year, it cannot be specified accurately. 
The festival is also now listed in the observed days for many more countries. 
 

24. In Religious Festivals, changed the checkbox caption “Include month starts” (visible when Jewish 
religious festivals are selected) to “Include Rosh Chodesh”. The list produced also makes it clearer 
when a one-day Rosh Chodesh festival or the second day of a two-day Rosh Chodesh festival 
falls on the first day of a Hebrew calendar month. 

 
25. In Add Reminders, the word “penultimate” in two of the drop-down lists has been replaced by 

“second last” to make life easier for users whose native language is not English. 
 
26. In Reminders by Month, the user prompt is now permanently visible. 
 
27. Changed the Hebrew month name Marheshvan to Marcheshvan. 
 
28. Corrected the USA state in which Savannah is located. 
 
29. The .wav filed used for audibly signalling imminent reminders was not being correctly chosen. 

Now it is. 
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30. Fixed two bugs in the Expression Calculator code – (a) when defining a new function, undefined 
variables in the definition were not being error trapped and (b) an erroneous error message was 
being generated by the mod operator under certain circumstances. 

 
31. Fixed a minor bug in the code for calculating the dates of equinoxes and solstices. 
 
Version 16.2 August 8, 2006 
 
1. Added code and a command button for generating a magic square of order N, where N lies in the 

range 3 to 100. The numbers forming the magic square are the integers 1, 2, 3, … N2. The 
algorithms used are described at http://mathworld.wolfram.com/MagicSquare.html. 
 
Note that magic squares of orders greater than 31 will be difficult to print “nicely” even in 
landscape mode. However, the relevant output data is also stored in the CSV (Comma Separated 
Variable) text file magsq.csv, which you may manipulate using a text editor or spreadsheet 
program, to customise and/or print the output for your own specific requirements. 

 
2. The stopwatch now has a dedicated command button on the main screen. 
 
3. When a Religious Festivals or Observed Days list is generated, the relevant output data is now 

also stored in the CSV (Comma Separated Variable) text file results.csv. You may manipulate this 
file, using a text editor or spreadsheet program, to customise the output for your own specific 
requirements. In addition, when a list of Jewish festivals is generated for any year in the range 
1583 to 3000, your local starting and ending sunset times (unadjusted for DST, if any) for each 
date are added to each line in this file. 

 
4. Added two check boxes “Include Sabbaths” and “Include month starts” to the Religious Festivals 

form. These check boxes only become visible when Jewish festivals are selected. Their purpose is 
to enable more comprehensive lists of Jewish holy days to be generated. 

 
5. In Religious Festivals, the religion chosen is now a “sticky” value. 
 
6. In the Geometry Calculator, added the parallelogram and the trapezium (trapezoid in the United 

States) to the list of 2D geometric objects for which key attribute values may be calculated. 
 
7. In the Geometry Calculator, when calculating the various attribute values of the frustum of a cone, 

the slant height of the complete cone is now also calculated. This value is useful when creating 
the curved surface of the frustum of a cone from a plane sheet of material. 

 
8. In the Expression Calculator, added the function fib(n) for evaluating the nth. Fibonacci number 

and the function luc(n) for evaluating the nth. Lucas number. 
 
9. In Date Conversions, added the Thai day colour to the output generated when a Gregorian date is 

converted.  
 
10. In memory of the author Douglas Adams, added Towel Day (May 25) to the list of Observed Days 

under “various” from 2001 onwards. For further information see:  
 

http://en.wikipedia.org/wiki/Towel_day. 
 
11. Added Cohuna, Victoria, Australia to Calendar Magic’s worldwide locations database. 
 
12. Based on input from Rafi Salasnik, made various minor updates to Jewish festival related 

information. Also modified the calculation of the dates of Yom HaShoah, Yom HaZikaron and Yom 
HaAtzmaut in line with a change introduced by the Israeli government in 2004. 

 
13. Tidied up the behaviour of various forms to ensure that focus is maintained when switching back 

and forwards between Calendar Magic and other applications. Also tidied up the “tab order” of 
controls on some forms. 

 
14. Fixed a bug in the Geometry Calculator – numeric input values in “E notation” were being 

rejected.Fixed a minor bug in the Geometry Calculator – returning to the main screen after any 

http://mathworld.wolfram.com/MagicSquare.html
http://en.wikipedia.org/wiki/Towel_day
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calculation, and then returning to the Geometry Calculator again, was changing the colour of any 
red label text associated with input data. 

 
 
Version 16.1 May 25, 2006 
 
1. Added a new category “Old British Currency” to the Unit Converter containing 18 pre-

decimalisation British units of currency including some popular slang terms. 
 
2. Developed file driven functionality for automating the process of creating a personal unit converter 

database. The same functionality may be used to incorporate any additions and changes to 
Calendar Magic’s unit converter database into a personal unit converter database. For more 
detailed information, consult the section “Personalising the Unit Converter Database” later in this 
document and especially the sub-section “Automating the Update Process.” 

 
3. The Iranian Government has decided to discontinue the use of DST (Daylight Saving Time) from 

2006. Updated Calendar Magic’s DST information in line with this decision. 
 
4. Implemented a simple stopwatch function. To make the stopwatch visible, use the Ctrl+W 

keyboard key combination from the main screen. 
 
5. Added the calculation of the solar noon time to Sun and Moon Data output. Solar noon is when the 

sun appears highest in the sky at any particular location on Earth. Solar noon is of considerable 
interest to sundial enthusiasts and to some Buddhists who are not allowed to eat after the solar 
noon on any day. 

 
6. Added a “Create Solar Calendar” button to the Sun and Moon Data screen. Through this button 

you may create a calendar showing sunrise times, sunset times or solar noon times for every day 
of a year for any location in Calendar Magic’s worldwide locations database. 

 
7. Added the dates of some Buddhist festivals to the list of Observed Days for Malaysia for 2006. 
 
8. Added Civic Day (first Monday in August) to the list of Observed Days for Canada. 
 
9. Added the city (Berlin) hosting the World Athletics Championships in 2009 to Gregorian date 

conversions output for that year. 
 
10. Restructured the output from “Days between Dates” to make it more tabular in appearance. 
 
11. Corrected time zone information for some cities and towns in Indiana in line with decisions made 

by the U.S. Department of Transportation in January, 2006. 
 
12. Corrected the time zone offset (+3 hours) for cities and towns in Sudan. 
 
13. Corrected the definition of the date of the early May holiday in the United Kingdom. 
 
14. Reduced the height of the “Enlarged View” form to ensure it is completely visible on displays 

running at low graphics resolutions. 
 
15. Widened the current time box at the top left of various forms to prevent “text clipping” with some 

Windows time formats. 
 
16. Fixed a problem with Réaumur temperature conversions on systems running the Hebrew version 

of Windows. 
 
Version 16.0 March 16, 2006 
 
1. In the Unit Converter you can now create your own personal unit converter database. Initially this 

personal database is identical to Calendar Magic’s unit converter database but two new command 
buttons have been provided to add, delete and update categories and units in the personal 
database. The “Add Categories and Units” button enables you to add new categories and units to 
your personal unit converter database. The “Edit Categories and Units” button supports the editing 
and deletion of existing categories and units in your personal database.  
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2. Option buttons have been provided to switch between using Calendar Magic’s unit converter 

database and any personal version. A  “Show Statistics” command button has also been added to 
the Unit Converter to display category and unit statistics for the currently selected unit converter 
database. For more detailed information, consult the section “Personalising the Unit Converter 
Database” later in this document. 

 
3. Added a new command button “Regnal Dates” for converting British sovereign regnal dates to 

historical Julian (years beginning on Jan. 1) or Gregorian form, as appropriate. This facility is 
primarily of interest to historians and other researchers studying old Acts of Parliament, wills, 
deeds etc. For further information, consult the section “Regnal Dates Conversion” in “Hints and 
Tips” later in this document. 

 
4. In response to a user request, added two buttons and a check box to the Calendar Comparison 

screen – “Next Year”, “Last Year” and “Ensure same day of week”. Their use is most easily 
explained by example. If the Calendar Comparison screen is set up with the Gregorian and 
Chinese calendars side-by-side and the Gregorian date Sunday, Jan. 29, 2006 specified, it is 
evident that the Chinese New Year occurs on that date in 2006. Now do one of the following. 

 
• Click the “Next Year” button to find out when the Chinese New Year will next occur on Jan. 29. 

The answer is in Gregorian year 2025. 
 

• Check the “Ensure same day of week” box and then click the “Next Year” button to find out 
when the Chinese New Year will next occur on Sunday, Jan. 29. The answer is in Gregorian 
year 2226. 

 
• Click the “Last Year” button to find out when the Chinese New Year last occurred on Jan. 29. 

The answer is in Gregorian year 1987. 
 

• Check the “Ensure same day of week” box and then click the “Last Year” button to find out 
when the Chinese New Year last occurred on Sunday, Jan. 29. The answer is in Gregorian 
year 1854. 

 
Note that, to try all four possibilities above, you must restore the Gregorian date Jan. 29, 2006 
before each operation. 

 
5. Tool-tips have been provided for the two buttons to explain their purpose and the Ctrl+T keyboard 

key combination may be used to terminate any unacceptably long operation. For further 
information, consult the section “Calendar Comparison” in “Hints and Tips” later in this document. 

 
6. Daily sunrise and sunset times are now displayed near the bottom right hand corner of the main 

screen for the worldwide location chosen in “Personal Settings”. The times are local times and 
adjusted for DST (Daylight Saving Time), if applicable. 

 
7. For “Days between Dates” you may now create a text file, localhols.dat, containing the dates of 

“non-business” days, for example local holidays. When calculating the number of business days 
between two dates, Calendar Magic will deduct any relevant “non-business” days listed in that file. 
For further information on how to structure and format the file localhols.dat, consult the section 
“Days between Dates” in “Hints and Tips” later in this document. 

 
8. In the Expression Calculator, there is now a single text box for expression input and the display of 

results. Results lines always begin with the characters “==>” to distinguish them from input lines. 
9. A new Print Session button has also been added. 
 
10. Modified the appearance of the Expression Calculator to make it look more “calculator like”. 
 
11. Added a new constant phi and a new function rand to the Expression Calculator. The constant phi 

is the “golden ratio”, equal to [1 + sqrt(5)] / 2. The function rand returns a random number in the 
range   0 <= x < 1. 

 
12. In the Geometry Calculator, added the “segment height h” to the calculated attributes of segments 

of circles. The segment height h may also be specified as one of the two input values. 
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13. Corrected a few key naming and ordering inconsistencies in the Scientific and Expression 
calculators. 

 
14. The Help PDF file may now be displayed from any Calendar Magic screen by pressing the F1 

function key. 
 
15. Added the date of Li Chun, the traditional start of Spring, to the list of Observed Days for China. 
 
16. Added the display of the current date and time to several additional forms. 
 
17. During the installation of V16.0, warning messages are now displayed prior to the files 

mycountry.dat and mycities.dat being overwritten. This provides an opportunity to make back-up 
copies of personal customised versions of these files, if you have not already done so. 

 
18. Fixed problem closing Calendar Magic after error message indicating that the file calmag.ini could 

not be found. 
 
19. Corrected the spelling of the Russian city Krasnoyarsk, the latitude of Warrnambool and the 

longitude of Gibraltar in Calendar Magic’s worldwide locations database. 
 
Version 15.9 January 29, 2006 
 
1. Incorporated VBGold’s Smart Print control into Calendar Magic in order to provide much more 

powerful and flexible printing capabilities. For example, any attached (physical or logical) printer 
may now be used, and titles and body text may now be formatted separately. Headers, footers, 
page numbers etc. may also be added, and printer settings include print quality, paper size, page 
orientation and number of copies. The various print settings are “sticky” values except currently 
the font for body text for which a fixed width font must be used in some situations to maintain 
vertical alignment. 

 
2. When importing or exporting reminder information via the Reminder Utilities screen (press Ctrl+U 

to display), the field separator may now be user specified as an alternative to those provided in the 
drop-down list of choices. Any “reasonable” single character field separator may be used except, 
fairly obviously, a digit or a letter. 

 
3. For those parts of Australia observing Daylight Saving Time (DST), updated its ending date in 

2006. This is a “one time” change, relating to the Commonwealth Games being held in Melbourne 
in March, 2006. 

 
4. Updated Time Zone information for various cities and towns in Indiana in line with decisions made 

by the U.S. Department of Transportation in January, 2006. The changes come into effect on April 
2. On the same date, the whole of the State of Indiana switches to Daylight Saving Time (DST) for 
the first time. 

 
5. Updated Observed Day information for Afghanistan, Cambodia, Fiji, Lao, Myanmar and Thailand. 
 
6. Added the date of Loi Krathong to the list of Observed Days for Thailand from 2005 onwards. 
 
7. In the Unit Converter, added the German unit pferdestärke to the list of units in the category 

“Power”. Also added mondo points and Paris points, plus several ancient Greek units (daktylos, 
podes, plethra, stadia), to the list of units in the category “Length and Distance”. Finally added 
mgons to the list of units in the category “Plane Angle”. 

 
8. Improved the appearance of “Sun and Moon” output. 
 
9. Corrected Time Zone data for several locations in Tennessee including Knoxville. 
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Version 15.8 December 13, 2005 
 
1. Enhanced the simple text find (Ctrl+F) function in Quick Notes by adding a find and replace 

function (Ctrl+R). In both cases, a case sensitive search option is now provided. Searches may 
also be carried out across the contents of all tabbed sheets or limited to the contents of the 
currently active tab, the latter being the default option. Further details may be found in the Quick 
Notes section later in this document. 

 
2. In Quick Notes, the Shift+F12 keyboard key combination may now be used to move to the 

previous tabbed sheet. 
 
3. Added a checkbox to the Edit Reminders screen through which all reminders containing a 

selected message may be deleted in a single operation. This is particularly useful when you create 
a series of reminders and discover “after the event” that you have made a mistake in the series 
definition. 

 
4. Added an option “Export reminders” to the Reminder Utilities screen (use Ctrl+U to access)  

through which reminder information may be exported from Calendar Magic into the text file 
myrems.txt. For more details, consult the section “Exporting Reminders from Calendar Magic” 
later in this document. 

 
5. In Global Distances, the ISO 3166-1 two-letter country code and the International Dialling code are 

now displayed for any country or dependency selected. 
 
6. In the Expression Calculator, the numeric part of any calculated result is now automatically copied 

to the Windows clipboard so that it can easily be re-used in the next calculation when required. 
 
7. In the Expression Calculator, explanatory comments may now be inserted in input, any text 

starting with the character ' being ignored. An example of input containing comments is: 
 

' Set values 
h = 30 ' height 
r = 17 ' radius 
' Calculate volume V of cone 
V = pi * r ^ 2 * h / 3 

 
8. Added a table of “special key combinations” to this document. 
 
9. A more elegant exit from Calendar Magic is now provided if the file calmag.ini cannot be found 

during loading of the main screen. This is usually due to launching Calendar Magic from a shortcut 
for which the “Start in” folder has not been specified or has been wrongly specified. 

 
10. Updated Daylight Saving Time (DST) information for Brazil and Israel. 
 
11. Updated Daylight Saving Time (DST) information for the United States, from 2007 onwards, as a 

result of the Energy Policy Act of 2005. Also, the State of Indiana has decided to observe DST 
throughout the state from 2006. 

 
12. Updated Thai observed day information for 2006. 
 
13. In “Days between Dates”, added an extra output line “The dates differ by n days.” 
 
14. In the Unit Converter, added “Litres/100 miles” to the list of units under the category “Fuel 

Consumption by Distance”. This rather bizarre unit is used by the trip computers in some Mazda 
cars. 

 
15. Added Mosman, New South Wales, Australia and Okotoks, Alberta, Canada to Calendar Magic’s 

worldwide locations database. 
 
16. In line with current usage, changed the country names French Guyana and Laos in Calendar 

Magic’s worldwide locations database to French Guiana and Lao respectively. 
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17. Based on user input, changed the name of the Antilles to Netherlands Antilles and added 
Sinterklaas (Dec. 5) to its list of Observed Days. 

 
18. Again based on user input, corrected the spelling of “Bocas del Toro” in Panama and added the 

Panamanian port of Almirante to Calendar Magic’s worldwide locations database. 
 
19. Fixed reminder list refresh bug when Edit Reminders screen was accessed more than once with 

reminders being added between accesses. 
 
Version 15.7 September 15, 2005 
 
1. Implemented an “Expression Calculator” for calculating the values of arithmetic expressions 

entered in normal (infix) form such as: 
 

(1.973 * 23.987) / (67.987 - 23.854) 
 
and 
 

(2 * pi + sqrt(19.75) - 17 * ln(23.3)) / (pi^2 + 0.987) 
 
In more complex situations, values of expressions may be assigned to user defined variables 
which may be subsequently re-used in other arithmetic expressions. User defined functions are 
also supported. 
 
For further details, consult the “Expression Calculator” section later in this document. 

 
2. When updating or deleting a reminder, a knowledge of its reminder number (rem#) is no longer 

required. Instead, left-click the reminder in the reminder list to select it, then either (a) update one 
or more of its fields and press the “Save Updated Reminder” button, or (b) press the “Delete 
Reminder” button. The selected reminder is highlighted by the presence of a “>” sign at the 
extreme left. 

 
3. The Reminder Utilities screen may now be invoked from both the main screen and the Edit 

Reminders screen by using the Ctrl+U key combination. 
 
4. Calendar Magic may now be opened in a screen other than the main screen by adding an optional 

field to its command line thus: 
 

"C:\Program Files\Calendar Magic\calendar.exe" /X 
 
where X is the access key for the command button which normally brings up the required screen. 
 
For example, to open Calendar Magic with the Quick Notes screen displayed, use the command 
line: 
 

"C:\Program Files\Calendar Magic\calendar.exe" /Q 
 
The optional parameter may be specified in either upper or lower case. Clearly, if Calendar Magic 
has been installed in a folder other than the installation default, the example above must be 
modified accordingly. 

 
5. In Quick Notes, the F12 function key may now be used to move through the tabbed sheets in 

order. 
 
6. Responding to a user request, Hebrew festival dates may now be generated for any year from 7 

C.E. to 9999 C.E.. Julian dates are used for years in the range 7 to 1582 C.E. while Gregorian 
dates are used from 1583 onwards. 

 
7. Added VJ Day (August 15) to the list of Observed Days under “various”. 
 
8. In the Unit Converter, the drop-down list of categories now contains “Weight” as a synonym for 

“Mass”, and “Speed” as a synonym for “Velocity”. These do not imply new categories, merely 
alternative names for two existing categories. 
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9. In the light of user feedback, changed the button caption “Log” to “Ln” in the Scientific Calculator. 
 
10. Updated the definition of the date of Respect for the Aged Day in Japan. Prior to 2003 this was a 

fixed date (September 15) but it is now defined to be the third Monday in September. 
 
11. Fixed a bug in the “Reminders by Month” display of out-of-date reminders – if more than one 

reminder of type “Every year” occurred on the same day, only one of these reminders was being 
displayed. 

 
Version 15.6 July 14, 2005  
 
1. Added a “Quick Notes” facility with 15 tabbed sheets for miscellaneous plain text items, entered 

through the keyboard or pasted from the Windows clipboard. To bring up Quick Notes, left-click 
the new Quick Notes command button on the main screen. If some Quick Notes items already 
exist, they will be displayed on the appropriate tabbed sheets. If no such items exist, the tabbed 
sheets are readied to receive new items. Each sheet can hold a maximum of 65535 characters. 

 
Quick Notes sheets may be edited, items copied or deleted, new items added etc. The standard 
Windows keys Ctrl+A, Ctrl+C, Ctrl+P, Ctrl+V and Ctrl+X may be used. The contents of Quick 
Notes are “sticky”, being automatically saved in the text file mynotes.txt when the Quick Notes 
facility is closed or when Calendar Magic is exited. You may also initiate a manual save at any 
time via the Ctrl+S keyboard key combination. The identity of the last sheet used is also “sticky”. 
 
The contents of a Quick Notes sheet may be edited in “enlarged view” (press the F11 key) and 
any changes made are automatically retained on exiting “enlarged view”. Also, pressing Ctrl+S in 
“enlarged view” causes a return to “normal view” followed by a save of sheet contents. 
 
The names of the 15 tabs may also be changed. If the tab name to be changed is not in the “front 
row”, click on it to bring it to the front. Then double-click the tab name and provide a new name 
when prompted. Tab names are also “sticky” items. 
 
When creating a new tab name, you can create a keyboard “access key” for the tab by preceding 
any character in the name by an ampersand (&). For example, if you type in: 
 

&To Do List 
 
as a tab name, it will appear on the tab as: 
 

To Do List  
 
and you can access the tab by using the Alt+T keyboard key combination. Fairly obviously, access 
keys for controls on any screen should be unique, i.e. no two controls should have the same 
access key. Note that the characters “M”, “O” and “P” are already being used for access keys for 
controls on the Quick Notes screen. 
 
A “Put Sheets into Order” button has also been provided to put the sheets into logical order based 
on tab names. 
 
Quick Notes also incorporates a simple search function for finding occurrences of specified text 
strings. To initiate a new search, use the Ctrl+F key combination and, when prompted, input the 
text to be found. If the specified text occurs more than once, use the F3 key repeatedly to run 
through the various occurrences. The search function is not case sensitive. 
 
Uses of Quick Notes range from the creation of simple “to do” lists to acting as an extended 
Windows clipboard for multiple plain text items. For example, one sheet might be reserved for 
regularly used text snippets such as your name and address. 

 
2. Replaced the “Friday the 13th.” command button by a new “In Which Months?” command button 

to provide more generalised functionality. The new button lists, for a given year, the months in 
which a specified day of the month falls on a specified weekday. For example, in 2005, the 15th of 
the month falls on a Thursday in September and December only. 
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3. Added a fourth type of Planning Calendar – one showing, for any day in a specified year, its day of 
year number and also the number of days still to go until the end of the year. 

 
4. Modified the Alarm Clock in order that an alarm can be repeated at regular intervals of n minutes, 

hours or days, where the interval n is an integer in the range 1 to 99. The “repeat logic” has been 
adjusted slightly to ensure that an alarm set to go off every 7 days, say, will occur at the same 
time on every occasion. The number of repetitions is also user definable in the range 0 to 99. 

 
5. For fiscal calendars, the start day for each fiscal week may now be any day of the week as chosen 

from a drop-down list on the Planning Calendars screen. Any selection made applies to fiscal 
calendars only and does not affect the “sticky” option for the week start day, defined via the 
Personal Settings button on the main screen, for all other yearly and monthly calendars. 

 
6. For fiscal calendars, the displayed start and end dates are now calculated more logically and also 

displayed irrespective of the first fiscal month. 
 
7. In the Geometry Calculator, any input value may now be specified as a simple arithmetic 

expression using not more than one of the arithmetic operators + - * / and ^, representing 
respectively addition, subtraction, multiplication, division and raising to a power. Examples are:  

 
5 * 23.79 
2.57 / 2  
2 ^ 0.5 

 
The space characters on either side of an arithmetic operator are optional. 

 
8. Added a “Clear Results Boxes” button to the Geometry Calculator, which clears any calculated 

results while leaving input values and/or expressions untouched. This avoids re-inputting values 
and expressions when minor input changes have to be made. 

 
9. The F1 key may now be used as an alternative to clicking the Help button on the main screen. The 

Help button has also been moved to the lower right-hand corner of the main screen. 
 
10. The Esc key may now be used as an alternative to clicking a “Return to Main Screen” command 

button or pressing the Alt+M keyboard key combination.  My thanks to B. R. “BeAr” Ederson for 
pointing out an easy implementation method for this facility. 

 
11. When producing an enlarged view of any output by pressing the F11 key, it is no longer necessary 

for the text-box containing the output to have “the focus”. 
 
12. Added Olympic Games data for London in 2012. 
 
13. Fixed a bug in the Geometry Calculator caused by the introduction of colour customisation. 
 
14. Fixed a bug in the Geometry Calculator which occurred in countries where a comma is used as 

the decimal point when more than one solution was generated for a calculation. 
 
15. Fixed a rarely occurring bug in the calculation of fiscal week numbers. 
 
Version 15.5 June 2, 2005 
 
1. Created a single file, calmag.ini, for the “sticky” data values which used to be spread across 

multiple files (myalarm.dat, myfsizes.dat, myopt.dat, myplaces.dat, mysigfig.dat). This makes it 
easier to add further customisation options to Calendar Magic in future releases. However, 
existing “sticky” data values are not retained. 

 
2. Created flexible colouring options for Calendar Magic screens covering: 
 

Screen backgrounds 
 

Non-button text 
 

Button backgrounds 
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Screens may be colour customised individually, or grouped together for colour customisation. 
Button background colours may also now be assigned to the various logical button groupings on 
the main screen. Colour choices for screens are “sticky”, i.e. remembered once chosen. 

 
3. The “Set Your Location” button on the main screen has been renamed “Personal Settings”. More 

importantly, this button is now used for setting your country and location, for setting the start day 
for calendar weeks, and for colour customisation of screens. 

 
4. Created a separate form for Planning Calendars to support the display and printing of individual 

planning calendars. 
 
5. Added the creation of fiscal calendars with fiscal week numbers as a third Planning Calendar 

option. Any fiscal calendar created is specified through four parameters: 
 

• The year in which the fiscal calendar begins. 
 

• The starting day of each fiscal week (Saturday, Sunday or Monday as selected via the 
Personal Settings button). 

 
• The first month of the fiscal calendar. Clearly any fiscal calendar not starting on Jan. 1 will 

spread across two calendar years. 
 

• How fiscal week number 1 is determined. Currently the possibilities are “Week with first 
day of first month”, “First full week of first month” and “First week with at least 4 days”. 

 
6. Modified the layout of the planning calendar with ISO week numbers to make it consistent with the 

layout of generated fiscal calendars. 
 
7. Implemented a Pregnancy Calculator for calculating the due date of a pregnancy and other 

pregnancy related dates. 
 

8. In the Unit Converter, the names of selected categories and units are now “sticky” values. 
 
9. Added “week of the year”, as calculated in the United States, to the output from Date Conversions 

for dates from Jan. 1, 1780 onwards. 
 
10. In the Time Calculator, results are also now displayed as decimal values in response to a user 

request. In addition, the formatting of results of the form d:h:m:s has been improved. 
 
11. The current day of the week is now displayed on the main Calendar Magic screen. 
 
12. In the Geometry Calculator, the colour of label text associated with input data now changes to red 

rather than yellow, since red text is easier to read against many coloured backgrounds. Similarly, 
in the Alarm Clock, the “Alarm On” message  is now shown in red for the same reason. 

 
13. Fixed a minor bug in the Scientific Calculator. When changing number base, and when checking 

and unchecking the Inv and Hyp buttons, the main display was not receiving back the focus (i.e. 
the blinking cursor for number entry was not being restored). 

 
Version 15.4 April 14, 2005 
 
1. Converted code from Visual Basic 5 to Visual Basic 6. If not already installed, the Microsoft Visual 

Basic 6 runtime files are now required and may be downloaded from many Web sites, for 
example: 

 
http://www.karenware.com/powertools/runtimes.asp 

 
2. Provided more user flexibility, in the choice of sounds produced by Calendar Magic, by switching 

from the use of Visual Basic’s Beep command to the sndPlaySound 32-bit Windows API. Three 
default WAV files are now provided – alarm.wav, calculator.wav and reminder.wav – for use by the 
alarm clock, scientific calculator and imminent reminders warning respectively. You may replace 

http://www.karenware.com/powertools/runtimes.asp
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the default files with other WAV files (named identically) and future installations of Calendar Magic 
will not overwrite your preferences. 

 
3. Added around 500 towns and cities to Calendar Magic’s worldwide locations database bringing 

the total to 8000. 
 
4. Provided default customised country and locations files, mycountry.dat and mycities.dat, covering  

the capital cities and towns in the world. If you have already created customised versions of these 
files, they will not be overwritten by the new default versions. 

 
5. Added the Revised Julian calendar to Calendar Magic, bringing the number of fully supported 

calendar systems to 23. This calendar was adopted by many Eastern Orthodox churches in 1923. 
It commenced on October 14, 1923 (Gregorian) and will remain identical to the Gregorian 
calendar until the end of February, 2800. From then onwards, minor differences between dates in 
the two calendars will occur because of different leap year rules. For further information see: 

 
http://en.wikipedia.org/wiki/Revised_Julian_calendar 

 
6. Adjusted the calculation of New Calendarist Style Orthodox observed days, for years from 2800 

onwards, to reflect the minor differences mentioned above. 
 
7. Implemented the astronomical version of the Persian calendar for Persian years up to 2500. It is 

based on the start of each Persian year being determined by the date and time of the Spring 
equinox in Tehran. The original Persian calendar implementation in Calendar Magic, based on 
arithmetic calculations and a complex system of leap years, has been renamed the Persian 
Arithmetic calendar to distinguish it from the new implementation. Output from the two 
implementations is remarkably similar, the two calendars never differing by more than 1 day at any 
time. 

 
8. Slightly modified the use of coloured buttons on the main Calendar Magic screen in the light of 

feedback received. 
 
9. Choosing coloured or all grey buttons on the main Calendar Magic screen, by means of the F12 

key, is now a “sticky” option, that is your last choice is remembered by Calendar Magic and re-
used whenever Calendar Magic is re-opened. 

 
10. In the “Alarm Clock”, added a text-box where you can type in an optional personal reminder of 

what is to be done when an alarm occurs. 
 
11. In Month Calendars, you may now leave the Year text-box blank to return to the current calendar 

year for any calendar system (other than the French Revolutionary calendar where the year 
reverts to year 1 of the calendar). 

 
12. In the Time Calculator, the limitation on input day values has been increased from 32767 to 

2147483647, with a corresponding increase in the sizes of results.  
 
13. In “Before or After”, double-clicking either output text-box will now re-apply the offset to the 

calculated date. This is useful for rapidly calculating a series of dates separated by the same 
offset. 

 
14. Added dates of Mother’s Day and Father’s Day to lists of Observed Days for a number of 

additional countries. 
 
15. Added the Ching Ming Festival (Tomb Sweeping Day) to the list of Observed Days for China. 
 
16. In “Date Conversions” when the spin button is used to increment/decrement dates, improved the 

handling of situations where the supported lower or upper limit of a calendar system has been 
reached. 

 
17. Sticky “What Time is it in?” places are now held in the file myplaces.dat. 
 

http://en.wikipedia.org/wiki/Revised_Julian_calendar
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18. Changed the way in which default data values are provided during installation. As a result, certain 
installation files no longer have to be renamed to ensure that user specified values are not 
overwritten. 

 
19. Corrected two dates in the list of Observed Days for Iran and fixed a bug in the DST adjustment 

code for Iran. My thanks to Shihab Salehi for pointing out these errors. 
 
20. Fixed a rarely occurring bug in the code for converting Persian arithmetic calendar dates to Julian 

day values. 
 
Version 15.3 March 18, 2005 
 
1. Made numerous minor changes to the user interface in line with recommendations from Kaj 

Nielsen. Also, at his suggestion, improved the logical grouping of buttons on the main Calendar 
Magic screen and introduced colour coding of main buttons to highlight the logical groupings. If 
you prefer Calendar Magic’s “classic appearance”, use the F12 key to turn button colouring off and 
on. For this to work, the main screen output text box must have “the focus”, i.e. a blinking cursor 
must be visible in that text box (left-click in the text box if it is not visible). 

 
2. Added around 250 towns and cities to Calendar Magic’s worldwide locations database bringing 

the total to nearly 7500. 
 
3. Added the current time and date to the Alarm Clock display. 
 
4. Added a capability to the Unit Converter to enable the values of one selected unit in the 

conversion results to be watched during multiple conversions within the same category. 
 
5. In the Geometry Calculator, you may now specify the number of significant digits you wish 

displayed in results. Changing that number will automatically force a recalculation and redisplay. 
Note that the “Show near integers with full precision” check-box is no longer required and has 
therefore been removed. 

 
6. In “Before or After” a second output text-box has been provided from which it is easier to copy and 

paste any calculated date. 
 
7. In “What Time is it in?” the time for any worldwide location selected is now updated every minute. 
 
8. In “What Time is it in?” you may now use your own customised selection of favourite countries and 

locations instead of Calendar Magic’s worldwide locations database.  
 
9. The number of significant figures specified for results in both the Unit Converter and the Geometry 

Calculator are now “sticky” – that is Calendar Magic remembers the values and redisplays them 
whenever either form is subsequently reloaded. 

 
10. In the “What Time is it in?” form, the last country and town/city selected from Calendar Magic’s 

worldwide locations database are also now “sticky”, as are the last country and town/city selected 
from a list of favourites. 

 
11. Added several additional observed days to the list for Norway. 
 
12. Added St. Patrick’s Day to the list of observed days for the United States. 
 
13. Fixed a “printing” bug in the Geometry Calculator – when more than one solution to a problem 

existed, only one solution was being processed by “Print to Printer” and “Print to Text File”. 
 
14. Fixed a bug in unloading and reloading the Scientific Calculator when a number base other than 

base 10 had been selected. 
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Version 15.2 February 17, 2005 
 
1. A third utility function for reminders has been added to support the importation of simple reminder 

information from other programs via a text file. For further information, see the section entitled 
“Importing Reminders into Calendar Magic” later in this document.  

 
2. Implemented two variations of the modern Hindu lunisolar calendar – those used in the Indian 

state of Gujarat and the region Saurashtra within Gujarat. The three calendars are identical except 
that the start of the new year in each calendar occurs at a different point. In the North Indian 
version, a new year begins at the start of the month Chaitra; in the Gujarat version, a new year 
begins at the start of the month Kartika; in the Saurashtra version, a new year begins at the start 
of the month Ashada. In Calendar Magic, the three calendars are therefore described as Hindu 
lunisolar Chaitra, Hindu lunisolar Kartika and Hindu lunisolar Ashada. 

 
3. When using the “What Time is it in?” capability, as soon as a country is chosen, the current time in 

the first town or city in that country, in Calendar Magic’s database, is now automatically displayed. 
The effect of this is that, for any country with only one (political) time zone, there is no longer any 
need to choose a town or city to see the current time in that country. A new caption below the 
country name also indicates whether one or multiple time zones are in operation in the country. 

 
4. The design of the “What Time is it in?” form has been improved in line with feedback received 

from a Danish user, Kaj Nielsen. 
 
5. In the Unit Converter, you may now specify the number of significant digits you wish displayed in 

results. Changing that number will automatically force a recalculation and redisplay. 
 
6. Added additional old Danish units of length, area, volume and mass to the Unit Converter. This 

information was provided by Kaj Nielsen who also corrected the plural forms of various unit 
names.  

 
7. Added additional old Swedish units of length, area and mass to the Unit Converter. 
 
8. Improved the use of diacritic marks in the names of towns and cities in various European and 

South American countries. Kaj Nielsen provided additional input. My thanks to Kaj for all his input 
and careful checking activities. 

 
9. To satisfy a request from an Australian user (his video recorder would not accept year values 

greater than 2004), the output from Gregorian date conversions now shows up to 5 earlier years 
with calendars identical to that of the year in the date input.  

 
10. Added coverage of Buddhist religious festivals. The festivals and dates listed are based on fixed 

dates in the Chinese lunisolar calendar. However, Buddhist festivals and dates vary from country 
to country and between different branches of the Buddhist faith, with local lunar calendar systems 
often being used. The information must therefore be treated with considerable caution. 

 
11. Updated Observed Day information for Denmark using information provided by Kaj Nielsen. 
 
12. Updated Observed Day information for India. Added some Tamil New Year data for both India and 

Sri Lanka. 
 
13. Added World Red Cross Day (May 8) to the list of Observed Days under “various”. 
 
14. Added date of Super Bowl Sunday, where known, to the Observed day list for the USA. 
 
15. Added Grandparents’ Day (fourth Sunday in September) to the lists of Observed Days for 

England, Scotland, Wales and Northern Ireland. 
 
16. Added a line to the Inno Setup installer script for Calendar Magic to resolve a problem 

encountered by a user on Windows XP when running without administrator privileges. An option is 
also now provided, during installation, to add Calendar Magic to your Windows start-up folder. 

 
17. Version history information (enhancements, changes, bug fixes etc.) is now stored in the separate 

file history.pdf. 
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Version 15.1 January 18, 2005 
 
1. Added a drop-down combo box to the “Observed Days” form containing the currently displayed 

observed day descriptions in alphabetical order, together with their dates, in the selected year. For 
countries with many observed days, for example the United States, this provides an easier way of 
finding the date of any observed day without searching through a long list. The combo box list is 
automatically updated to reflect country and/or year changes. 

 
2. Added a similar drop-down combo box to the “Religious Festivals” form. The combo box list is 

automatically updated to reflect religion and/or year changes. 
 
3. For those who believe in biorhythms, added some biorhythm calculations to the output from “This 

is Your Life 
 
4. Added American Samoa, Guam, Northern Mariana Islands, Niue, South Georgia, and Wallis and 

Futuna to the list of countries and dependencies. 
 
5. Added observed day information for American Samoa, Guam, Northern Mariana Islands, Niue, 

South Georgia, and Wallis and Futuna. 
 
6. The American and British Virgin Islands are no longer combined together. Updated the observed 

day information for both territories. 
 
7. Updated observed day information for 2005 for various countries including Anguilla, Cayman 

Islands, Fiji, Gibraltar, Iran, Malaysia, Samoa, St. Helena, Taiwan, and the Turks and Caicos 
Islands. 

 
8. Added DST start date for Israel in 2005. The DST end date has yet to be decided. 
 
9. Removed Handsel Monday from the Observed Day lists for England, Wales and Northern Ireland. 
 
10. Added the start of the Hindu Vikram New Year to the list generated by the command button “New 

Years’ Dates” for Gregorian years from 2000 to 2043. 
 
11. Added Huntigowk (April 1) to the Observed Day list for Scotland. 
 
12. Fixed a problem in the data file FDates.csv. One of the observed day descriptions (Feast of St. 

Peter and St. Paul) for various South American countries was too long. 
 
Version 15.0 November 9, 2004 
 
1. The reminders functionality has been considerably enhanced in this release by providing support 

for easily defining a reminder for a series of dates. Three types of date series may be defined. 
Examples of the three types are:  

 
• November 17, 2004 and every 10 days thereafter to the end of September, 2005. 

 
• The second Thursday in every month from December, 2004 to June, 2005. The selection 

options include first, second, third, fourth, penultimate, last and every.  
 

• Day 5 of every month from February, 2005 to July, 2005. In specifying the day value, apart 
from the obvious choices of 1, 2, 3, ………, 31, other available options are penultimate, last 
and every. If a day value does not exist in any month specified, for example day 31 in 
November, it is ignored for that month. 

 
Once defined, the reminders within all three types of series are treated by Calendar Magic as 
being independent of each other, enabling individual reminders in the series to be updated and 
deleted. 

 
2. In Reminders by Month, the current date is now highlighted in green (unless it has associated 

reminders, in which case it continues to be highlighted in red). 
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3. In Reminders by Month, when using the “Print Month with Active Reminders” button, day values 
associated with active reminders are now underlined in the printed month calendar. A new 
command button “Print to Text File” has also been added for copying the same output, 
unformatted, to a text file. If no name is specified for the text file, the default name results.txt is 
used. The text file can then be opened in a word processing program to apply more extensive 
formatting. 

 
4. When Calendar Magic is initiated, the  "List All Reminders” command button may now be 

surrounded by a red or orange rectangle. “Red” indicates that one or more reminders have been 
set for the current date. “Orange” indicates that one or more reminders are imminent within the 
next seven days. 

 
5. Added two utility functions for reminders, displayed by pressing the Ctrl+U key combination when 

the text-box on the main Calendar Magic screen “has the focus”, i.e. a blinking cursor is visible in 
the text-box (left-click in the text-box if it is not visible). One utility function prints reminder internal 
data structure information. The other compacts the main reminders file, person.dat, to reduce its 
size. Users will rarely require to use these reminder utilities in normal circumstances. 

 
6. Consolidated all Sun and Moon related calculations under a new command button “Sun and Moon 

Data”. Location specific Sun and Moon data can now be easily calculated for any location in 
Calendar Magic’s locations database for any date in any year from 1583 to 2200. Other non-
location specific results continue to be available up to the year 3000. 

 
7. The former Sun and Moon command buttons have been eliminated, as have Sun and Moon based 

results in Date Conversions output. Now there is one command button to initiate all relevant 
calculations and there is also no need any longer to use the Set Location command button to 
choose the location of interest. 

 
8. In “Global Distances”, whenever a city or town is selected, its latitude and longitude are now 

displayed. 
 
9. Improved the code for preventing the same reminder being stored more than once in Calendar 

Magic. 
 
10. When describing years and dates in the Vietnamese calendar, transliterations of the Vietnamese 

names for the celestial stems and terrestrial branches are now used, in preference to 
transliterations of the Chinese equivalents. 

 
11. Setting a new worldwide location in Calendar Magic now triggers a message of confirmation. Left-

clicking “OK” returns the user to the main screen. 
 
12. Provided an “access key”, Alt+H, for the Help command button. 
 
13. Eliminated any use of Windows system default colours for backgrounds in Calendar Magic. On 

PCs with user modified Windows system default colours, the appearance of various Calendar 
Magic screens could be less than desirable. 

 
14. In Religious Festivals, when a new religious type is chosen, the year value no longer changes to 

the current year, unless it is out-of-range for the new religious type. 
 
15. Daylight Saving Time (DST) information for Brazil and Jordan has been updated. 
 
16. Corrected definition of Labour Day in New Zealand. 
 
Version 14.9 October 8, 2004 
 
1. When using “Reminders by Month”, days earlier in the current year or last year (see new “Last 

Year” option button below), associated with out-of-date reminders, are now highlighted in blue. 
Left-clicking a “blue day” shows the out-of-date reminder(s) for that day. 

 
2. Added a “Last Year” option button to “Reminders by Month” enabling out-of-date reminders to be 

viewed right back to the beginning of last year. 
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3. Added a new command button “Factor Calculator” for finding: 
 

• The prime factors of any positive integer up to 60 digits in length. This uses highly efficient 
code for factorising integers developed by Shamus Software (http://indigo.ie/~mscott). 

 
• The Highest Common Factor (HCF) and Least Common Multiple (LCM) of a list of up to 20 

integers separated by commas. There is a size limitation of 2147483647 on any integers listed 
and on any calculated LCM. Note that the term Greatest Common Divisor (GCD) is sometimes 
used instead of Highest Common Factor (HCF). 

 
A relatively fast CPU is required for factorising large integers quickly. Users who wish to factorise 
integers larger than 10^60 – 1 may also use the Shamus Software code (factor.exe) from a 
command prompt for integers up to 10^80 – 1. 
 
Any number or list of numbers entered in the Factor Calculator is automatically copied to the 
clipboard, making it easy to re-input values, possibly followed by minor corrections and revisions. 

 
4. Enhanced the “What time is it in?” capabilities by adding the identification of Time Zone 

abbreviations and the calculation of their time offsets relative to GMT (UTC) and also relative to 
“local”, i.e. relative to the city or town specified by a user using Calendar Magic’s “Set Location” 
button. There are currently around 130 Time Zone abbreviations in the drop-down list. More can 
easily be added if requested. 

 
5. Added conversion to and from Roman numerals via a new category “Roman Numerals” in the Unit 

Converter. 
 
6. Added the megalithic inch to the list of units of length in the Unit Converter. 
 
7. Hindu festivals may now be listed for years in the range 2000 to 2043 (the previous upper limit 

was 2031). The new data is also incorporated into Indian observed day lists. 
 
8. In the Time Calculator, if no time is entered in the left data input box for a calculation, the current 

time is now assumed. 
 
9. Restructured error handling. With the exception of the Scientific Calculator, error messages are 

now displayed using standard Visual Basic message boxes. This simplifies the handling of error 
messages, enables Status Display text-boxes to be removed from some Calendar Magic forms, 
and makes debugging easier in certain situations. 

 
10. Fixed a minor bug in Reminders by Month – when a new month was selected via the drop-down 

combo box, any reminder details being displayed were not being replaced by the standard prompt. 
 
Version 14.8 September 6, 2004 
 
1. Developed and tested V14.8 on a Windows XP SP2 based system. No SP2 related problems 

were encountered. 
 
2. Global distances are now automatically calculated as soon as both locations have been specified. 

As a result, the Calculate Distance command button is no longer needed and has therefore been 
removed from the Global Distances form. 

 
3. When using the Time Calculator, the keyboard Enter key may now be used as an alternative to 

left-clicking the Calculate button. Also, when performing addition, if the right data input box is 
empty, the time in the left input box is now added to any previously calculated result. These 
changes facilitate the rapid addition of a list of times by entering each one in the left data input box 
and then pressing the keyboard Enter key. 

 
4. Added a “Clear All Boxes” command button to the Time Calculator screen to clear both input and 

output data boxes. 
 
5. In the Geometry Calculator, 2D and 3D geometric objects are now listed separately, with users 

able to select either list through two new option buttons labelled “2D Objects” and “3D Objects”. 
 

http://indigo.ie/~mscott
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6. Added a “Show near integers with full precision” check-box to the Geometry Calculator. If 
unchecked, any result within 0.0000001 of an integer will be displayed as an integer, providing 
nicer looking output but with the possibility of some loss of precision. Note that 
checking/unchecking this check-box will force an automatic recalculation and display of existing 
results, making it easy to compare the two methods of displaying results. 

 
7. In the Geometry Calculator, when evaluating the attributes of television screens, two option 

buttons are now provided for selecting either a standard TV 4:3 or a widescreen TV 16:9 aspect 
ratio. Switching between aspect ratios also forces an automatic recalculation and display of any 
existing results. 

 
8. In the Scientific Calculator, error messages may now be cleared by pressing the keyboard Escape 

key. 
 
9. In the Unit Converter, as soon as a specific category and unit have been chosen, a conversion is 

now immediately performed for 1 unit. For example, choosing the category “Mass” and the unit 
“Kilograms” causes an immediate conversion of 1 kilogram into all the other units in the category 
“Mass”. 

 
10. Every command button on the main Calendar Magic screen now has an associated explanatory 

tool-tip. 
 
11. Added National Aboriginal Day (June 21), Saint-Jean-Baptiste Day (June 24) and Multiculturalism 

Day (June 27) to the list of observed days for Canada, Software Freedom Day (August 28) to the 
list of observed days under “Various”, and St. Bartholomew’s Day (August 24) to the list of 
Western Christian religious festivals. 

 
12. When saving a new reminder, Calendar Magic now checks whether the reminder already exists. If 

it does, an appropriate error message is displayed. Also when saving a new reminder, if it already 
exists with a different “year value”, for example “This year only” instead of “Every year”, Calendar 
Magic now ensures that duplicate reminders are never generated. 

 
13. The error message generated by Calendar Magic for a “not found” file did not specify the name of 

the missing file. This has been rectified. 
 
Version 14.7 
 
1. Added a Help button for displaying the bookmarked readme.pdf file. 
 
2. When printing from Calendar Magic screens containing a print button, a printer font size may now 

be specified. 
 
3. Added a “Print Month with Reminders” command button to the Reminders by Month screen. The 

size of the font may again be specified when producing print-out. 
 
4. In all cases, respecified printer font sizes are “remembered” by Calendar Magic for future use. 
 
5. In Enlarged View mode (entered by pressing the F11 function key), a spin button has been 

provided for decreasing/increasing the display font size. The font size is changed in steps of 1 and 
is currently restricted to lie in the range 8 to 20. 

 
6. Added circular rings (annuli) to the list of 2D objects in the geometry calculator. 
 
7. In “What time is it in?”, when DST is “on” for any location, the location’s current Time Zone offset 

now includes the adjustment of +1 hour for DST. In previous releases, the unadjusted Time Zone 
offset was displayed. 

 
8. Whenever an alarm is set, a message in the Alarm Clock status display now reminds users not to 

close Calendar Magic. 
 
9. In the scientific calculator, when an error occurs, the tool-tip text for the main display now changes 

to describe how to clear the error message. Once the error message is cleared, the tool-tip text 
reverts back to the normal “Main display – left-click to copy value to clipboard.” 
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10. In the scientific calculator, more helpful error messages are now generated in error situations for 

x^y calculations. 
 
11. One of the explanatory tool-tips for star polygons was not being reset properly for other 2D and 3D 

geometrical objects. This minor bug has been fixed. 
 
12. Re-organised and improved the readme file to highlight various points. Added a section on the use 

of the seven stack independent memories in the scientific calculator. 
 
13. Switched to pdfFactory Pro for the creation of Calendar Magic’s readme file. 
 
Version 14.6 
 
1. Added television screens to the list of 2D objects in the geometry calculator. 
 
2. Added {n/k} star polygons to the list of 2D objects in the geometry calculator. For a description of 

{n/k} star polygons, see: 
 

http://mathworld.wolfram.com/StarPolygon.html 
 

For those unfamiliar with star polygons, various explanatory tool-tips have been provided for some 
of the relevant labels and text-boxes. 

 
3. A  correlation constant may now be defined for the date of commencement of the Mayan long 

count calendar system via a new command button on the Date Conversions screen. Any integer 
value in the range 400000 to 700000 may be chosen. Two widely used values by experts are 
584283 (the default in Calendar Magic) and 584285. 

 
4. Sikh religious festivals are now processed for “On This Date”. 
 
5. Added dates of Hola Mohalla, Bandi Chhor Divas and Parkash Guru Nanak Sahib, for years in the 

range 2003 to 2020, to the list of Sikh religious festivals.  
 
6. Added the result of the calculation of the relevant Mayan “Lord of the Night” to the date 

conversions output. 
 
7. Added National Doctors’ Day (March 30) to the list of observed days for the USA. 
 
8. Added the calculation of the circumradius and inradius of triangles to the geometry calculator.  
 
9. Incorporated improved values for Delta-T, the difference between Dynamical Time and Universal 

Time, for years in the range 1980 to 2014. 
 
10. Improved the wording of the note after the British Julian/Gregorian calendar for 1752. 
 
11. When adding the contents of any memory location to the stack, by left-clicking one of the buttons 

M1, M2, ………… M7, any unstacked input in the main display is now automatically added to the 
stack before the contents of the memory location. 

 
 
12. In the geometry calculator, switching between degrees and radians no longer causes all input and 

output boxes to be cleared. Instead, angle values are now converted accordingly. 
 
Version 14.5 
 
1. When object attribute values are calculated in the geometry calculator, the colour of label text 

associated with input data now changes to yellow, in order to distinguish more clearly between 
data input and calculated results. 

 
2. Added segments of a circle to the list of 2D objects in the geometry calculator. 
 
3. Added cuboids (box shapes) to the list of 3D objects in the geometry calculator. 

http://mathworld.wolfram.com/StarPolygon.html


 35

 
4. Updated and corrected observed day information for France. 
 
5. Added additional observed day information for Thailand in 2005. 
 
6. Added dates of Mothers’ Day and Fathers’ Day for a few more countries. 
 
7. Added International Elephant Day (March 13) to list of observed days. 
 
8. Added Planck length and Planck time units to appropriate categories in the unit converter. 
 
9. Added Russian mils to plane angle units in unit converter. 
 
10. Updated Commonwealth Games, European Athletics Championships and World Athletic 

Championships data. 
 
11. Pressing the Reminders by Month command button now displays the current month, even when 

no reminders have yet been defined, enabling all reminders to be set by the “double-clicking” 
method. 

 
12. Associated “access keys” (Alt-letter key combinations) with the various command buttons in the 

time and geometry calculators. 
 
13. In the geometry calculator, when more than one solution exists, the message in the Status Display 

now highlights the fact. 
 
14. Improved the calculation of the attributes of rectangles with very large equal heights and lengths. 
 
15. Fixed bug related to the recalculation of “greyed out” results, after existing attribute values are 

edited, for ellipses, frusta of cones and frusta of pyramids on square bases. 
 
16. Corrected Daylight Saving Time (DST) beginning and ending dates for Israel in 2004. 
 
17. Changed date of Al-Naqba from May 14 to May 15. 
 
Version 14.4 
 
1. My sincere thanks to David Gordon who acted as a beta version tester “par excellence” for V14.4. 
 
2. Added a new command button “Time Calculator” for performing simple arithmetic on times entered 

using one of the formats d:h:m:s or h:m:s or m:s or s where d is the number of days, h the number 
of hours, m the number of minutes and s the number of seconds. In this release: 

 
• Two times can be added together. 

 
• One time may be subtracted from another. 

 
• A time may be multiplied or divided by a positive number. 

 
Any time result produced is rounded to the nearest second and must be less than 32768 days 
(slightly under 90 years), with larger values generating an (integer) overflow error message. 

 
When the value of d, h, m or s is at the extreme left of an input string, it may be as large as 32767 
the maximum normal integer value Visual Basic 5 can handle. Otherwise, in line with the usual 
conventions for writing a time, h must be less than 24, and m and s less than 60. 

 
Additional time based functionality may be added in future releases depending on feedback from 
users. 

 
3. Added a new command button “Geometry Calculator” for evaluating key attributes (area, 

perimeter, volume, surface area etc.) of various 2D (circle, ellipse, rectangle, regular polygon, 
sector of a circle, square, triangle) and 3D (Buckminster ball, cone, cube, cylinder, frustum of a 
cone, frustum of a pyramid on a square base, regular dodecahedron, regular icosahedron, regular 
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octahedron, regular pyramid on a polygonal base, regular pyramid on a square base, regular 
tetrahedron, sphere) geometric objects. In the case of triangles, a complete triangle solver is 
provided. 

 
The geometry calculator complements the scientific calculator and unit converter in Calendar 
Magic to enhance the overall versatility of the product. Additional 2D and 3D objects may be 
added in future releases, as may additional object attributes, depending on feedback from users. 

 
4. In the scientific calculator, improved the evaluation of sin(x), cos(x) and tan(x) when working in 

degrees with x an exact integer. For example, working in degrees,  sin(180) now evaluates to 
exactly 0 rather than to the extremely small quantity 1.22460635382238E-16. Similarly, tan(90) 
now causes an overflow error rather than evaluating to the extremely large number 
1.63317787283838E+16. Note that this change is mainly cosmetic since, in practical terms, the 
impact of the change is minimal. 

 
5. In the scientific calculator, modified some underlying code to enable the Int, Frac and Mod 

operators to be applied to numbers greater than the maximum long integer in Visual Basic 5, 
namely 2147483647, although there remains an upper limit on Mod operands (now 10^15 - 1). 

 
6. In the scientific calculator, incomplete input of the form 1234567E was not being trapped as an 

error, leading to Calendar Magic closing on an “illegal operation”. This has been fixed. 
 
7. In the unit converter, modified the definitions of computer storage units to bring them into line with 

an International Electrotechnical Commission (IEC) standard. According to this standard, the 
prefixes kilo, mega, giga, tera, peta and exa are to be used for powers of 1000, whereas the new 
prefixes kibi, mebi, gibi, tebi, pebi and exbi are to be used for powers of 1024. Thus, for example, 
1 megabyte = 1000000 bytes and 1 mebibyte = 1048576 bytes. The unit converter now handles 
both. 

 
For further information, see http://physics.nist.gov/cuu/Units/binary.html. 

 
8. Added dates of start and end of Oktoberfest to list of observed days for Germany. 
 
Version 14.3 
 
1. Closing any screen (sub-window) in Calendar Magic other than the main screen, by left-clicking on 

the “X” button in the top right-hand corner of the screen, will now return the user to the previous 
screen. Prior to V14.3, closing any screen in Calendar Magic in this way closed the complete 
program. 
 
Note that this is not quite the same as using the "Return to Main Screen" and "Return to Previous 
Screen" buttons. These hide the sub-window but it's still in memory, whereas the close button 
closes it properly. Returning to a closed sub-window will obviously cause it to be re-initialised. 
Returning to a hidden sub-window reveals it in its previous state. 

 
2. Many of the command buttons in Calendar Magic now have associated “access keys” defined, 

indicated by an underlined character in a button caption – for example “Year Calendars”. Users 
who prefer using the keyboard, rather than a mouse, may now trigger the command by holding 
down the Alt key and pressing the corresponding underlined letter key – for example Alt+Y.  

 
3. Using the “Set Location” command button, any user typing in a country or city/town name not in 

Calendar Magic’s locations database, will no longer cause an invalid myopt.dat file to be created. 
Instead, the erroneous input will be ignored. 

 
4. In Month Calendars and Compare Calendars, the Gregorian date on which any month starts is 

now displayed, if the Gregorian date exists. If not, the Julian date on which the month starts is 
displayed. 

 
5. In Month Calendars and Compare Calendars, when displaying Chinese and Vietnamese 

calendars, the cycle and year within the cycle are now displayed. 
 
6. In countries where a comma is used as the decimal point, the relevant scientific calculator data 

input button now displays a comma. In addition in such countries, when entering numbers into the 

http://physics.nist.gov/cuu/Units/binary.html
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calculator via the keyboard, either the comma or full stop key may be used to input a decimal 
point. 

 
7. Fixed a minor bug in “Compare Calendars” connected with the restoration of a calendar name 

after an “unable to complete operation” event. 
 
8. Fixed a minor bug in Reminders by Month connected with the double-clicking of today’s date to 

set a reminder for today. 
 
9. Made numerous minor cosmetic and consistency changes throughout the program. 
 
Version 14.22 
 
1. Fixed a bug encountered when trying to update and delete existing reminders. 
 
Version 14.21 
 
1. Fixed a serious bug which was only apparent when running Calendar Magic on PCs with non-

English regional settings. It was related to the fact that, on such PCs, Visual Basic 5 and Visual 
Basic 3 handle certain date related functions differently. 

 
Version 14.2 
 
1. Calendar Magic has been converted from Visual Basic 3 to Visual Basic 5 – a major undertaking. 

The main advantages of so doing are that Calendar Magic is now a 32-bit program and 
performance has been significantly improved. 
 

2. Freed up some screen “real estate” and eliminated five command buttons by providing access to 
all supported types of religious festivals from a new command button “Religious Festivals”. 

 
3. The F11 function key may now be pressed to produce an “enlarged view” of any lengthy output 

produced by Calendar Magic. For this to work properly, the text box containing the output must 
have “the focus”, i.e. a blinking cursor must be visible in that text box (left-click in the text box if it 
is not visible). To exit the enlarged view, press the F11 function key again or left-click the 
appropriate command button to return to the previous or main screen. 
 
“Enlargeable” output text boxes are identifiable by the tool-tip “Press F11 for a larger view of the 
output” when a user’s mouse cursor is hovered over a text box.  

 
4. When viewing reminders by month you may now double-click on any date to add a reminder for 

that day. The reminder date field is automatically pre-filled using this approach. It provides an 
alternative to using the “Create Reminders” command Button. 
 

5. Added the capability to list the dates of Chinese religious festivals in any Gregorian year in the 
range 1645 to 3000. 

 
6. Added the capability to list the dates of Sikh religious festivals in any Gregorian year from 1999 

onwards. 
 
7. Added a note, after the display of any French Revolutionary year calendar, about the structure of 

months in the French Revolutionary calendar. Also added an explanatory note at the end of the 
Islamic Festivals output to emphasise that, unlike Gregorian days, Islamic days run from sunset to 
sunset. As a result, each Islamic festival commences on one Gregorian day and finishes on the 
following one. 

 
8. Updated Coptic month names to coptized versions of ancient Egyptian calendar month names. 
 
9. Updated observed day information for Thailand in the light of copious input received from a user 

(Sister Nunbuoy). Also improved the handling of conversions to Thai solar (Suriyakati) calendar 
dates. 
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10. The current location and country are now displayed immediately below the “Set Location” 
command button, providing an immediate visual check that they have been set correctly. 
 

11. Switched to the Inno Setup Compiler for handling the installation of Calendar Magic. 
 

12. It is no longer necessary to install manually the Moon Phases font moon.ttf. 
 

13. Changed “Calendar Comparison” to “Compare Calendars” to reduce the amount of text on this 
command button. Also changed “Set Options” to “ Set Location”. 

 
Version 14.1 
 
1. Implemented the modern Bangla calendar throughout the relevant components in Calendar Magic 

(Year Calendars, Month Calendars, Calendar Comparison, Date Conversions, New Years’ Days). 
Defined in 1967, this calendar is widely used in Bangladesh and, since 1988, all official 
publications in Bangladesh have been dated using both the Gregorian and Bangla calendars. 

 
2. Added a new command button “Hindu Festivals” to display a list of Hindu festivals for any year in 

the range 2000 to 2031. The dates listed are those relevant to the northern half of India and are 
“data file” driven since it is extremely difficult to calculate such dates from first principles. 

 
3. The list of observed days for India in any year in the above date range also now includes these 

Hindu festivals. 
 
4. Added a new command button “Baha’i Festivals” to generate a list of Baha’i festivals for any year 

from 1845 (the start of the Baha’i calendar) onwards. 
 
5. At the request of a user in Saudi Arabia, users may now choose to display/print calendars with 

weeks starting on a Saturday. 
 
6. Added the relevant two-letter state abbreviation to each Brazilian town or city name in Calendar 

Magic’s worldwide locations database. In cases where, for time-zone reasons, it is necessary to 
distinguish between the western and eastern parts of a state, the state name abbreviation is 
followed by W for West or E for East.   

 
7. Made numerous additions and updates to observed days for various countries in Calendar Magic’s 

worldwide locations database. 
 
8. The observed days for Israel are now listed directly, instead of a reference to the Hebrew Festivals 

command button. 
 
9. Fixed minor bug concerning the Daylight Saving Time (DST) end date for Egypt. 
 
Version 14.0 
 
1. The observed days listed for any country now include the relevant New Year related, Christian 

festival related, Orthodox related, and Islamic festival related days. In previous releases such days 
were not given country by country but only listed once under “Various”. 
 

2. Added the dates of the beginning and end of Daylight Saving Time (DST) to the list of observed 
days, for any country using DST, for years from 2003 onwards. Note that, in some cases 
(Australia, Brazil, Canada, USA), DST does not apply in all parts of the country. 
 

3. Started the process of adding extra public holidays to lists of observed days, caused by certain 
observed days falling at the weekend. Additional observed days also added for many countries. 
Input from users will be gratefully received! 
 

4. Created a new command button for dates of Islamic festivals in any Gregorian year. 
 

5. Added the following observed days under “various” – International Thank You Day, International 
Women of Colour Day, International Children’s Day, International Children’s Book Day, 
International Migratory Bird Day, International Midwives Day, International Museum Day, 
International Day of the African Child, International Lefthanders Day, International Internet Day, 
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International Computer Security Day, International Volunteers Day and International Civil Aviation 
Day. 
 

6. At the request of a user, added the relevant Patron Saint’s day for each country to the lists of 
observed days for England, Northern Ireland, Scotland, Wales and the Republic of Ireland. Also 
added Trafalgar Day (Oct. 21) to the list of observed days for England. 
 

7. Updated Cambodian observed days information, thanks to input from a user (John McQuilan). 
 

8. Modified slightly the layout of the “What time is it in?” form to reduce the amount of screen space it 
occupies. 
 

9. In response to a user suggestion, added an explanatory note at the end of the Hebrew Festivals 
output to emphasise that, unlike Gregorian days, Hebrew days run from sunset to sunset. As a 
result, each Hebrew festival commences on one Gregorian day and finishes on the following one. 
 

10. In Calendar Comparison, changed the default status message to make it more clear that you can 
select any day value displayed by left-clicking it. 
 

11. Eliminated the need to install the font symbols.ttf, (but moon.ttf must still be installed if it is not 
already installed on a system). 
 

12. Underlining of red numbers in Calendar Comparison and Reminders by Month no longer extends 
to leading spaces. 
 

13. Fixed bug in “Before or After” code connected with results in which the “logical” resulting date 
does not exist, e.g. 1 month before March 31, 2004, 1 year after Feb. 29, 2004 etc. The solution 
adopted is to return the error message “Illogical request!”. If you have other suggestions, please 
let me know.  
 

14. Fixed heading and column alignment problem in Calendar Comparison and Reminders by Month 
reported by a user. 
 

15. Fixed screen problem with all white backgrounds not being exactly the same shade of white. This 
minor discrepancy was spotted by an eagle-eyed user. This occurred on rare occasions on a few 
PC systems. 
 

16. Changed starting year for Ethiopian observed day “Downfall of the Dergue” to 1992 since, 
according to a user, the event took place in 1991. 

 
Version 13.9 
 
1. Added a new category “Wavelength and Frequency” for amateur radio enthusiasts to Calendar 

Magic’s Unit Converter, in response to a user request. 
 

2. When Gregorian dates in the range Jan. 1, 1583 to Dec. 31, 3000 are converted to dates in the 
other supported calendar systems, the Moon’s phase, as seen in the northern hemisphere, is now 
displayed visually as part of the output. 
 

3. Added a “spin button” control to the Date Conversions form via which the date to be converted 
may be incremented or decremented in steps of one day. 
 

4. Added a “CEP countdown” to the output from Gregorian date conversions. This is a countdown in 
days to/from March 20, 2675 (Gregorian). For the significance of this date see: 

 
http://www.calendersign.ric.at/en/calendar-science/cep-pec/ 

 
5. Added around 20 more USA “observed days” to Calendar Magic’s database. 

 
6. Added World Wetlands Day (Feb. 2), First Day of Kwanzaa (Dec. 26) and Kwanzaa Karamu (Dec. 

31) to the list of Observed Days. 
 

7. Added International Mother’s Day (May 11) to the list of Observed Days. 

http://www.calendersign.ric.at/en/calendar-science/cep-pec/
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8. Changed “Asalapha Bupha” to “Asaka Bucha” in the list of Thai observed days, following feedback 

from a user. 
 
Version 13.8 
 
1. Responding to a user request, a new command button “On This Date” is provided in this version. It 

will list all events (observed days) in Calendar Magic’s database falling on any specified date. 
 

2. Another user pointed out that, whenever a Julian Day value is displayed as a decimal number, the 
calculation should be performed using UT (Universal Time) and not local time. This is now done in 
V13.8. 
 

3. Provided a second type of “planning calendar” requested by a user --  a regular Gregorian 
calendar with ISO week numbers added.  

 
4. V13.8, satisfying another user request, also produces the equivalent Japanese nengo year as part 

of the output when a Gregorian date in any year from 1873 to 2015 is converted to dates in the 
other calendar systems. The Japanese nengo year is also listed in the “New Years’ Days” output. 

 
5. To improve clarity on some monitor screens, highlighted days in red in the “Calendar Comparison”  

and “Reminders by Month” displays are now additionally underlined. 
 
6. Lists of Observed Days for any country are no longer produced for years after 3000 (Gregorian). 

This is because some of the astronomical algorithms involved, e.g. in connection with the Chinese 
and Vietnamese calendars, cannot be fully trusted beyond 3000. 

 
7. Deleted Liberation Day (July 22) from list of Polish observed days. Apparently this holiday has not 

been celebrated since 1989. 
 
Version 13.7 
 
1. Added 200+ more cities and towns to Calendar Magic’s worldwide database bringing the total 

number to more than 7200. 
 

2. Added World Heart Day and UK public holidays around Christmas, Easter and New Year to list of 
Observed Days. 
 

3. Added Hindu New Year and Hindu Vikram New Year to list of Observed Days.  
 

4. In the Unit Converter, the conversion factor for litres/100 kilometres in the “Fuel Consumption by 
Distance” category was wrong. This has been fixed. 

 
5. Replaced all red text on a grey background with yellow text in order to make it more readable on 

an LCD screen. 
 

6. Fixed minor bugs connected with the day of the week on which Anzac Day falls and the date of 
the October Bank Holiday in Ireland. 
 

7. Left-clicking on the number in the main scientific calculator display, to copy it to the clipboard, 
followed by Ctrl+V to paste it into another application did not always work. This has been fixed. 

 
Version 13.6 
 
1. Provided a major enhancement to Calendar Magic, in the form of a new command button – What 

time is it in? – through which the current time (and date) at any of the worldwide locations in 
Calendar Magic’s database may be calculated and displayed. Users are warned that this is the 
first time that Daylight Saving Time (DST) rules for world countries have been incorporated into 
Calendar Magic, so that the code may require further refinement. This is especially true of 
countries with complex or evolving DST rules, such as Australia, Brazil and Canada. 
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2. Increased the number of worldwide locations in Calendar Magic’s database by approximately 
1000 bringing the total number of cities and towns up to 6980. 
 

3. Expanded the list of countries and dependencies covered by Calendar Magic to around 230, and 
added associated observed days. 

 
4. Added a few more observed days for Canada (e.g. Mothers’ Day and Fathers’ Day). 

 
5. Added the relevant two- or three-letter state/territory abbreviation to each Australian town or city 

name in Calendar Magic’s worldwide locations database. 
 
Version 13.5 
 
1. Enhanced Calendar Magic’s unit conversion capabilities significantly. The number of conversion 

categories has increased by 11 to 80 and, more importantly, the total number of units handled has 
more than doubled – from 640 to 1610. At the same time, took the opportunity to rationalise some 
of the category names. 

 
2. Numbers may now be copied from the clipboard into the scientific calculator’s input display field 

using the usual Ctrl+V command for pasting. Such clipboard input is appended at the right to any 
existing input data in this field which has not yet been stacked. 
 

3. The automatic copying of any Calendar Magic output to the Windows clipboard has been de-
implemented since it could, on rare occasions, overwrite clipboard data a user wished to retain for 
later use. Instead the usual Ctrl+A, Ctrl+C and Ctrl+X commands may be used. 
 

4. Switched over to PDF format for the ReadMe file. This gets round the need to maintain two 
versions of the ReadMe file and also provides a better, more readable document for users who 
cannot read Microsoft Word files. Bookmarks have also been added. Note that, if you install V13.5 
on top of a previous version of Calendar Magic (recommended), you can safely delete the old 
readme.doc and readme.txt files afterwards. 

 
Version 13.4 
 
1. Added a new command button -- “Month Calendars” -- for creating single month calendars for any 

month in any year in any of the 21 calendar systems supported by Calendar Magic. 
 

2. Added a new command button -- “Before or After” -- for calculating the date n days, weeks, 
months or years before or after a specified Gregorian date. A text field is provided for specifying 
the offset n. 
 

3. Added a new “Alarm Clock” command button for defining an alarm for a given time on a given 
date. A user may specify the duration of the alarm which may be repeated, after a specified “quiet” 
time, up to five more times. Calendar Magic must be running at the time of the alarm for the alarm 
to sound. 
 

4. Added a “spin button” to the year input field for full year calendar creation, via which any year 
value may be increased or decreased in steps of one, and a new calendar automatically 
generated. 

 
5. When generating full year calendars or converting dates, the desired process may now be initiated 

by pressing the Enter key after entering a year or date. As a result, both input screens have been 
simplified by the removal of one command button and the new approach is consistent with that 
used in the “Calendar Comparison” capability. 
 
Also, if the year or date input field is left blank (to indicate the current year or date), Calendar 
Magic automatically fills in the blank field when the Enter key is pressed. 

 
6. Modified the “Observed Days” input screen in line with the previous two paragraphs. 
 
7. Added “Observed Days” information for the Falkland Islands and French Polynesia. 
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8. Responded to a user request by renaming the Fasli and Persian Qadimi calendars “Parsi Fasli” 
and “Parsi Kadmi” respectively. 
 

9. Added the relevant two-letter province abbreviation to each Canadian town or city name in 
Calendar Magic’s worldwide locations database. 
 

10. Fixed a bug in the handling of Hebrew date conversions when the input date field was left blank. 
 
Version 13.3 
 
1. Significantly enhanced the month-by-month calendar comparison capability by adding support for 

eleven additional calendar systems -- Armenian, Baha’i, Coptic, Egyptian, Ethiopic, Fasli, French 
Revolutionary, Modern Hindu solar, Parsi Shenshai, Persian Qadimi and Sikh Nanakshahi . Any 
two from 21 different calendar systems may now be compared in this manner. 
 

2. In previous versions of Calendar Magic, no two calendars could be compared on a month-by-
month basis before November, 1582 (Gregorian). Comparisons may now be made as far back as 
January, 7 C.E. (Julian) provided that, of course, the two calendars existed at that time. 

 
Version 13.21 
 
1. Fixed a bug in the handling of Fasli calendars and dates. 
 
Version 13.2 
 
1. Made substantial changes to the main Calendar Magic window in order to reduce the amount of 

screen “real estate” being used. To achieve this, the number of command buttons has been 
reduced from 40 to 26 – mainly by the creation of two new command buttons, “Calendars” and 
“Date Conversions”, via which all full year calendars and all date conversions are respectively 
initiated. 

 
2. Added twelve new types of full year calendars -- Armenian, Baha’i, Coptic, Egyptian, Ethiopic, 

Fasli, French Revolutionary, Modern Hindu solar, Indian National, Parsi Shenshai, Persian Qadimi 
and Sikh Nanakshahi -- all available through the “Calendars” command button. 
 

3. Dates in these twelve new calendar systems may be converted to dates in all the supported 
calendar systems, as may Mayan dates. 

 
4. Added the Afghan, modern Hindu lunisolar and Vietnamese calendars to the month-by-month 

Calendar Comparison capability, enabling any two from ten calendars to be compared month-by-
month. 

 
5. Restructured the code and data for generating the dates of Hebrew Festivals. 

 
6. Added additional observed days for Singapore (Vesak Day, Hari Raya Pausa, Hari Raya Haji). 

 
7. Added approximate date of start of Diwali to list of Observed Days common to many countries. 

  
8. The month-by-month calendar view of reminders no longer highlights in red “every year” 

reminders which are now “out-of-date” in the current year. 
 

9. In the output from List All Reminders, “every year” reminders, which have yet to occur this year, 
are now also listed for next year. 
 

10. Fixed bug causing the occasional skipping of Hindu old and modern lunisolar calendar year starts 
when using the New Years’ Days command button. 
 

Version 13.1 
 
1. The listing of Observed Days and the underlying code and supporting data tables have been 

radically overhauled. Observed Days in Calendar Magic’s database are now listed on a per 
country basis (rather than one long combined list for all countries), with the option of including or 
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excluding various observed days common to many countries. 
 

2. The number of “Observed Days” in Calendar Magic’s database has been increased by 
approximately 100% to around 1200. 
 

3. The underlying code and data tables for listing Western Christian festivals and Orthodox Christian 
festivals have also been radically changed. In addition, Orthodox Christian festivals are now listed 
both in “new style” (Gregorian calendar based fixed dates) and “old style” (Julian calendar based 
fixed dates). 

 
Version 13.0 
 
1. Improved ease-of-use with the introduction of a new “Edit Reminders” command button through 

which existing reminders may be changed or deleted. In previous versions, these operations were 
buried more deeply in the Calendar Magic user interface. 

 
2. New “Reminders by Month” command button supports the display of a calendar for any month, in 

this year or next year, with day numbers highlighted in red for those days in the month for which 
reminders have been set. Left-clicking on any “red day” will cause the reminders set for that day to 
be displayed. 
 

3. Existing reminder related command buttons have been renamed to “List All Reminders” and 
“Create Reminders”. 
 

4. Added United States Tax Day to list of observed days. 
 

5. Added Holocaust Memorial Day to list of observed days. 
 

6. Information in “Gregorian Dates” output, showing when a calendar may be first re-used, now 
covers both the case when the date of Easter is not regarded as relevant and the case when the 
date of Easter must be the same for both years. 
 

7. Tidied up command button names on main Calendar Magic screen. 
 

8. The “Clear Mem” command button now clears the contents of memory N, where N is the top-of-
stack value. In earlier versions of Calendar Magic, all seven memories were cleared. 
 

9. Output from the “This is Your Life” command button now includes a person’s date of birth in other 
calendar systems and the Chinese year (Dog, Pig, Horse etc.) in which the person was born. 
 

10. Fixed minor bug associated with the retention of user specified options when a new version of 
Calendar Magic is installed on top of an existing version. 
 

11. Corrected definition of date of Election Day in the USA. 
 

12. Fixed devious bug under which a certain global variable was not being properly reset. 
Restructured handling of variable month lengths in calendars to minimise this kind of error re-
occurring. 
 

13. Fixed problem with some Chinese/Vietnamese dates and calendars. A line of VB code had 
inadvertently been commented out. 
 

14. Calendar Magic now traps any attempt to specify a reminder for Feb. 29 “every year”. 
 
Version 12.2 
 
1. New “Date Detective” command button tabulates the weekday on which a specified Gregorian 

date d/m occurs for each of the years in the specified range y1 to y2. 
 

2. Date conversions are now supported to the Sikh Nanakshahi calendar. The traditional Sikh New 
Years Day is also listed via the “New Years’ Days” command button. 
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3. Added calculation of position in Dionysian period to output generated by “Gregorian Date Facts” 
button. 
 

4. Added calculation of equivalent Tibetan year to output generated by “Gregorian Date Facts” 
button. 
 

5. After installing Calendar Magic V12.2, future versions installed on top of V12.2 will preserve user 
specified option settings. 
 

6. The age of the Moon in “Gregorian Date Facts” is now calculated more accurately. 
 

7. The “This is Your Life” command button now calculates your “Chinese age”. In China, a person 
has an age of 1 at birth, and his/her age increases by 1 each Chinese New Year. 
 

8. Updated algorithm for converting Dynamical Time to Universal Time. 
 

9. Fixed a bug associated with the naming of months in the modern Hindu solar calendar. 
 

10. Output produced by the “Gregorian Date Facts” command button now indicates whether 
corresponding ISO calendar year contains 52 or 53 weeks. “Gregorian Analysis” command button 
also shows the numbers of 52-week and 53-week ISO calendar years in the 400-year Gregorian 
cycle. 
 

11. When Calendar Magic is run, all set reminders are now automatically displayed on the initial 
screen. 
 

12. During the input of any new reminder, a continuous count is now displayed of the number of 
characters being entered. 
 

13. The “cancel” button on various Calendar Magic input boxes now works properly rather than 
producing output for the assumed current year or date. 
 

14. Added some facts about Easter Day to the output generated by the “Christian Festivals” command 
button, including the years in which Easter Day occurs earliest in the year (March 22) and the 
years in which Easter Day occurs latest in the year (April 25). 
 

15. Output text on the main Calendar Magic screen is now preserved when using the “Calculator”, 
“Global Distances”, “Unit Converter” and “Calendar Comparison” command buttons. 
 

16. Provided date conversions and New Year dates for three variations of the Zoroastrian calendar, 
namely the Parsi Shenshai calendar, the Persian Qadimi (or Kadmi) calendar and the Fasli 
calendar. 
 

17. Output from “Gregorian Date Facts” button now includes the GPS week in which the specified 
date occurs. 

 
Version 12.1 
 
1. Wrote a generalised function to handle definitions of observed days like “Third Monday in August” 

and “Last Friday in February”. Rewrote “Observed Days” code to use this function. 
 

2. Altered output of Chinese major solar terms slightly to list those occurring in the Gregorian year 
input and to calculate the dates at UT. 
 

3. Added some observed days related to the Chinese calendar. These include the Chinese New 
Year, the Lantern Festival, the Matsu Festival, the Birthday of the Lord Buddha, the Dragon Boat 
Festival (Tuen Ng), the Seven Sisters’ Festival (Chinese Valentine’s Day), the Chung Yuan 
Festival, the Mid-Autumn Festival, Confucius’ Birthday, and the Chung Yeung Festival. 
 

4. Added Commonwealth Games, European Athletics Championship, and World Athletics 
Championship data for Gregorian Date Facts information. 
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5. Added “Europe Day” (May 9) to the list of observed days. 
 

6. In line with a user request, where sensible, the various input prompts will assume that the current 
calendar year or date is intended, whenever an input field is left empty and the “OK” button 
pressed. 
 

7. Date conversions are now supported to the Balinese Pawukon calendar. 
 

8. Added a new command button for showing the dates in any Gregorian year of the New Years’ 
Days in many other calendar systems. 
 

9. When converting Gregorian dates to Roman form, Calendar Magic now converts the equivalent 
Julian date. This is more logical than converting the Gregorian date directly. 
 

10. Fixed a bug in the conversion code for Hindu solar calendar dates. 
 

11. Fixed a “Type Mismatch” error on invoking the scientific calculator, encountered in some countries 
where the comma is used as the decimal point character. 

 
Version 12.0 
 
1. Added support for the Vietnamese calendar system, a variant of the Chinese calendar. 

Vietnamese calendars may be generated and Vietnamese dates converted to dates in other 
calendar systems via two new command buttons. 

 
2. Added support for the Afghan calendar system, essentially the Persian calendar system with 

different month names. Afghan calendars may be generated via a new command button, and 
Afghan dates converted through the existing “Persian Date Facts” button. Also created a "tool tip" 
for this command button showing the Afghan month names and values. 

 
3. Enhanced the code behind all “Date Facts” buttons to provide additional conversions from various 

calendar systems to Vietnamese and Afghan format. 
 

4. Enhanced the “calendar comparison” capability with the addition of the Persian calendar to the list 
of options. 

 
Version 11.02 
 
1. Fixed a “Type Mismatch” error encountered in some countries where the comma is used as the 

decimal point character. 
 

2. Added explanatory tool tips for “Monday Start” and “Sunday Start” option buttons. 
 
Version 11.01 
 
1. Improved the clarity of output generated by the “Days Apart” command button. 

 
2. Corrected date of Epiphany for the USA. 

 
3. Added date conversions to Thai Buddhist format. 
 
Version 11.0 
 
1. Sunrises, sunsets, moon rises and moonsets may now be calculated for nearly 6000 locations 

around the world for any Gregorian date up to the end of the year 2200. Both the “Gregorian Date 
Facts”, the “Sun Facts” and the “Moon Facts” command buttons now generate relevant sunrise 
and sunset information. A “Set Options” command button has been added via which any location 
in the Calendar Magic locations database may be chosen. The default choice is London, England. 
 

2. The new “Global Distances” command button calculates the "great circle" distance between any 
two cities or towns in the underlying database from their respective latitudes and longitudes. 
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3. The new “Calculator” command button provides access to a stack based scientific calculator with 
a visible stack. 
 

4. The new “Unit Converter” command button provides access to a unit converter for converting 
between over 640 American, British and metric units in 69 different categories. 
 

5. Added date conversions to the Armenian and Egyptian calendar systems. 
 

6. Brought names of months in various calendar systems in line with those listed in the Millennium 
edition of Calendrical Calculations by Reingold and Dershowitz. 
 

7. Made output from various “Date Facts” buttons less verbose while retaining all important 
information. 
 

8. Reduced size of Calendar Magic executable file by more than 10% by rationalising code behind 
the various “Date Facts” buttons. 
 

9. Hebrew, Hindu lunisolar and Islamic calendars and dates can now be handled back to 7 AD, 
rather than 1583 AD as previously implemented. 
 

10. The various “Date Facts” buttons now provide week day names in the various calendar systems, 
where appropriate. 
 

11. Added UK Golden Jubilee holiday to list of observed days for 2002 and adjusted date of UK 
Spring holiday for the same year. 
 

12. Added Quasimodo Sunday to the list of religious festivals generated. 
 

13. Made default radio button selection “more intelligent” when entering reminders. 
 

14. The various “Date Facts” buttons now show conversions to the Thai Buddhist calendar. 
 

Version 10.3 
 
1. Added USA Boy Scout Day, Nurses’ Day, National Day of Prayer, Juneteenth, Parents’ Day, 

Coast Guard Day, Friendship Day, and National Children’s Day to list of Observed Days. 
 

2. Corrected date of American Constitution Day. 
 

3. Output generated by the main command buttons in Calendar Magic is now automatically copied to 
the Windows clipboard. 
 

4. Corrected definition of Australia Day and related public holiday. My thanks to Brian Morley for 
explaining this to me. 
 

5. Changed command button caption “Special Days” to “Observed Days”. 
 

6. Made various changes to the list of Observed Days as a result of some correspondence with Bob 
Bemer. My thanks to Bob for his knowledgeable input. 

 
7. Responding to another user request, a new command button has been added to convert French 

Revolutionary calendar dates to dates in the other supported calendar systems. Conversion to 
French Revolutionary calendar dates has also been added to the other “Date Facts” conversions. 
 

8. To improve ease-of-use, input prompts have been enhanced for Hebrew, Hindu, Islamic, Persian 
and French Revolutionary calendar “Date Facts”. 
 

9. Brought output from Hindu solar calendar in line with that produced in the Millennium edition of 
Calendrical Calculations by Reingold and Dershowitz. This represents a change from the first 
edition. 
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10. The “Sun Facts” and “Moon Facts” command buttons now generate the dates of solar and lunar 
eclipses respectively. 

 
Version 10.2 
 
1. The “Gregorian Calendar” command button now generates an alternative “planning calendar” for 

any year, in addition to the usual kind of Gregorian calendar. This responds to a specific 
enhancement request received from a user. 

 
Version 10.1 
 
1. Added many new dates and anniversaries to the list of “Observed Days”. Also, when two or more 

list items fall on the same date, they are now output in country order. 
 
2. The “Gregorian Date Facts” command button has been enhanced to convert any date input into 

Roman date format. For example, January 9 in any year converts to V Idus Ianuarias. 
 

3. Some minor bug fixes. 
 
Version 10.0 
 
1. Replaced the “Indian Calendar” and “Indian Date Facts” buttons, present in earlier releases, by 

two new “Hindu Calendar” and “Hindu Date Facts” buttons, based on the Hindu lunisolar calendar. 
 
2. All the “Date Facts” buttons in Calendar Magic now also convert dates to equivalent dates in four 

Hindu calendar systems – the old solar calendar system, the old lunisolar calendar system, the 
solar calendar system, and the lunisolar calendar system. 
 

3. The "Gregorian Date Facts" button now displays the first year in the future at which the calendar 
for the year in the date entered may be re-used. 
 

4. Added an analysis of the frequency of occurrence of the fourteen different types of Gregorian 
calendar to the output generated under “Gregorian Analysis”. 

 
Version 9.02 
 
1. Fixed minor bugs in the calculation of Election Day and Inauguration Day in the USA. 

 
2. Added Primary Election Day in USA to list of Observed Days. 
 
Version 9.01 
 
1. Fixed bug when Calendar Magic was run on a system with Windows short date formats other than 

dd/mm/yy. 
 

2. Made Calendar Magic more accommodating to different Windows short date formats. 
 
Version 9.0 
 
1. Added support for the Persian calendar system via command buttons for generating Persian 

calendars and for producing a list of Persian “date facts”. 
 

2. Added a command button for Julian “date facts”. 
 

3. The various “date facts” command buttons now generate equivalent dates in the other supported 
calendar systems and also in Coptic and Ethiopic date formats. 
 

4. Chinese and Baha'i dates are now displayed in a form which "calendar purists" will find more 
acceptable. 
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5. Replaced the continuous count-down to the Gregorian year 2100 by the more relevant continuous 
display of the Julian day value. 
 

6. Various minor bugs have been fixed in the program code and in the documentation. 
 
Version 8.11 
 
1. Fixed bug which led to some erroneous results in countries such as the United States where dates 

are written in the form m/d/y, rather than d/m/y as in the United Kingdom. The problem centred 
around the use of the Visual Basic DatePart function at certain points in the Calendar Magic VB 
code. 
 

2. Added Mothers’ Day And Fathers’ Day in Australia to list of Observed Days. 
 
3. Converted to Setup Generator for program distribution and installation. 
 
Version 8.1 
 
1. Added code to convert Gregorian, Chinese, Hebrew, Indian and Islamic dates to Baha’i calendar 

date format. 
 

2. Added code to convert Gregorian, Chinese, Hebrew, Indian and Islamic dates to Mayan long 
count, civil haab and religious tzolkin formats. 
 

3. Fixed bug in code which converted an Indian national date to Julian Day (JD) number form. 
 

4. Added Septuagesima, Quinquagesima, the Solemnity of Mary, the Presentation of the Lord, the 
Transfiguration of the Lord, the Birth of the Virgin Mary, the Celebration of the Holy Cross and the 
Mass of the Archangels to the list of Christian Festivals in any Gregorian year. 
 

5. Restructured "Christian Festivals" code to make it easier to add new festival days. 
 

6. Any output displayed by Calendar Magic may now be printed, in its entirety, by using the usual 
Ctrl+P keyboard combination. 
 

7. With start of new millennium, changed continuous countdown from 2000 to 2100. 
 

8. Also altered code so that dates entered with 2-digit year values are correctly interpreted. For 
example 1/1/00 is now interpreted as Jan. 1, 2000 and not as Jan.1, 1900. 
 

9. Fixed bug in production of Julian calendars. 
 

10. Restructured “Orthodox Festivals” code to make it easier to add new festival days. Added the 
Baptism of Christ in the Jordan, the Meeting of Our Lord (Hypapante), Saint Theodore, the 
Annunciation of the Theotokos, Thursday of the Great Canon, Saturday of Lazurus, the Dormition 
of the Theotokos, Nativity of the Theotokos, Exaltation of the Cross, Entry of the Theotokos into 
the Temple, and the Nativity of Our Lord Jesus Christ. 
 

11. Converted to Setup Factory for program assembly and installation. 
 

12. Each reminder now displays day of week, in addition to the date. 
 

13. The "Days Apart" command button now also produces the number of business days between two 
given dates. Two calculations are performed, one excluding the dates specified, and the other 
including both dates specified. 
 

Version 8.01 
 
1. Added special day information for Mexico. 
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Version 8.0 
 
1. Responded to a requirement from North American users of Calendar Magic, who are accustomed 

to seeing calendars constructed with Sunday as the first day of the week, although this is contrary 
to the ISO 8601 international standard. Option buttons, “Monday start” and “Sunday start”, are 
now provided on the main Calendar Magic screen to toggle between the display and printing of 
calendars constructed with respectively Monday and Sunday as the first day of the week. 

 
2. Calendar Magic also retains a note of these option button settings on exit from the program, and 

these settings are restored when the program is started up again. 
 

3. Any output displayed by Calendar Magic may now be selected, in its entirety, by using the Ctrl+A 
keyboard combination. Normally this action will be followed by Ctrl+C to copy the selected text to 
the Windows clipboard.  

 
Version 7.13 
 
1. Added code to convert Gregorian dates to equivalent dates in the ISO calendar.  

 
2. Added conversion to Roman numeral form for any Gregorian year in the range 1583 to 3999. 

 
3. Golden numbers are now displayed in Roman numeral form. 

 
4. “Week of year” (Gregorian Date Facts) now stresses that the calculation has been performed in 

line with the ISO 8601 international standard. Not all diaries and almanacs adhere to this standard 
for calculating the “week of year” in which a given date falls, or indeed for making Monday the first 
day of each week. 
 

5. Added Modified Julian Day (MJD) number for any Gregorian date. 
 

6. Added Lilian day number for any Gregorian date. 
 

7. Added Rata Die (RD) number for any Gregorian date. 
 

8. Out-of-date reminders, automatically purged by Calendar Magic, are now appended to the text file 
purged.dat, which may be opened using any text editor. This provides a “fall back” for recovering 
dates and details of events from the past. 

 
Version 7.12 
 
1. Corrected date of Quaid-e-Azam's birthday in Observed Days list. 
 
2. Removed Pakistan holiday on September 6 from Observed Days list, in line with recent 

government decision. 
 
Thanks go to Yasir Hayat for pointing out these inaccuracies. 
 
Version 7.11 
 
1. Fixed bug introduced into the display of some Indian National and Islamic civil calendars as a 

result of minor code additions in Version 7.1. 
 
Version 7.1 
 
1. Added Chinese calendar capabilities for any Chinese year from cycle 72, year 22 to cycle 94, year 

57 (1645 AD to 3000 AD).  
 
2. Added capability to convert Chinese dates to/from equivalent dates in the Gregorian, Hebrew, 

Indian National, Islamic civil and Julian calendars. 
 
3. Extended “Calendar Comparison” capabilities to include the Chinese calendar.  
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4. Added Observed Day information for China. 
 
Version 7.0 
 
1. Added "Sun Facts" button for calculating dates and times of equinoxes and solstices in any year 

from 1582 to 3000. 
 
2. Added "Moon Facts" button for calculating dates and times of the phases of the Moon in any year 

from 1582 to 3000. 
 
3. In "Calendar Comparison" screen, altered method of displaying "M T W T F S S" in attempt to 

resolve minor out-of-alignment problem reported by one user. 
 
Version 6.3 
 
1. Added additional Observed Day information for Austria, Czech Republic, Denmark, Finland, 

Gibraltar, Greece, Hungary, Iceland, Isle of Man, Japan, Malta, Norway, Poland, Portugal, Russia, 
Slovakia, Spain, Sweden and Turkey. 
 

2. Corrected definition of Waitangi Day (New Zealand). 
 

3. Fixed minor bug in calendar comparison when Indian calendar was at its lowest limit and other 
calendar was used to attempt to move backwards in time. 

 
Version 6.2 
 
1. Gregorian date prompts are now based on the Windows short date setting, e.g. d/m/y in the UK 

and m/d/y in the United States. 
 

2. Restructured "Observed Days" code to make it easier to add new special days. 
 
3. Added some special days for Switzerland. 
 
4. Altered Gregorian 400-year analysis so that Sunday is displayed as last day of the week. 
 
Version 6.1 
 
1. Altered program so that the text displayed, when "The Magic Series" button is pressed, is now read 

from an ASCII text file. This makes it easier for clients with customised versions to update the 
message displayed. 
 

2. Added calculation of "week of year" for Gregorian dates from 1/1/1583 onwards. 
 

3. Changed all calendar displays by making "Sunday column" last column in month, rather than first. 
This is in line with ISO 8601 international standard. 
 

4. Added output line for showing Gregorian dates in ISO 8601 international standard date format. 
 

5. Fixed minor bug which prevented display of Hebrew holy days in countries such as the USA where 
standard date format is not of form dd/mm/yy. 
 

6. Altered code for "week of the year" to bring it into line with ISO 8601 standard. 
 

Version 6.0 
 
1. A major enhancement to Calendar Magic with the introduction of a "calendar comparison" 

command button to invoke the side-by-side comparison of any two calendar systems (Gregorian, 
Hebrew, Indian National, Islamic civil and Julian) on a month-by-month basis. 

 
2. Added special 1752 calendar, the year in which Great Britain and its colonies moved from the 

Julian to the Gregorian calendar system. 
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Version 5.0 
 
1. Added Indian National calendar capabilities for Indian years in the range 1879 to 9920 (roughly 

equivalent to the range 1957 to 9999 in Gregorian terms).  
 
2. Added code to convert Indian national dates to/from Gregorian, Hebrew, Islamic and Julian dates. 
 
3. Added reminder imminent event "beep" and text colour change capabilities. 
 
4. Added information regarding modern Olympic Games to that displayed by "Gregorian Date Facts" 

command button. 
 
Version 4.0 
 
1. Extended handling of Gregorian dates back to the beginning of the Gregorian calendar (October 

15, 1582). 
 
2. Added capability to generate the Julian calendar for any year from 8 AD to 9999 AD. 
 
3. Added Hebrew calendar capabilities for Hebrew years in the range 5344 to 13759 (roughly 

equivalent to the range 1582 to 9999 in Gregorian terms). 
 
4. Added capability to generate Hebrew holy day information for any Gregorian year. 
 
5. Added Islamic civil calendar capabilities for Islamic years in the range 990 to 9666 (roughly 

equivalent to the range 1582 to 9999 in Gregorian Terms). 
 
6. Added code to convert between Gregorian, Hebrew, Islamic and Julian dates. 
 
7. Added code for calculating Orthodox Easter Day and the dates of the Orthodox festivals related to 

Orthodox Easter. 
 
8. Added code to calculate the Epact for Gregorian years. 
 
Version 3.0 
 
1. Added continuously changing display showing the countdown to January 1, 2000 in days, hours, 

minutes and seconds. 
 
2. Added additional button for various "Year 2000" related facts. 
 
3. Improved appearance of initial screen. 
 
Version 2.01 
 
1. Provided capability to copy results to the clipboard, and hence to word and text processors etc. 
 
2. Fixed minor bug in the code, which automatically removes out-of-date personal reminders. 
 
Version 2.0 
 
1. Major enhancements to allow the creation, update, deletion and display of personal reminders. 
 
Version 1.2 
 
1. Any results produced may now be printed at the press of a button, e.g. year calendars, lists of 

holidays and events in any year, "This is Your Life" facts etc. 
 
2. A complete analysis of the Gregorian calendar 400-year cycle, showing how often each day of the 

month falls on a Monday, a Tuesday, a Wednesday etc. It immediately becomes evident, for 
example, why the 13th day of the month is slightly more likely to occur on a Friday than on any 
other day. 
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Version 1.1 
 
1. Installation of Calendar Magic simplified by addition of a "set up" program to install Calendar Magic 

automatically. 
 
Version 1.0 
 
1. Original version. 
 


